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Safety warning notice

Å
WARNING: To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly 
on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, 
such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow 
the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the 
AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).



Contents

1 Product description

2 External component identification

Top components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–1
Display components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–1
Buttons, switch, and speaker. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–3
Keys  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–4
Lights  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–5
Pointing devices  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–6

Front components. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–7
Right-side components. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–8
Left-side components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–9
Bottom components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2–10

3 Illustrated parts catalog

Service tag . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3–1
Computer major components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3–2
Plastics Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3–9
Display assembly subcomponents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3–10
Mass storage devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3–11
Miscellaneous parts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3–12
Sequential part number listing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3–13

4 Removal and replacement procedures

Preliminary replacement requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–1
Tools required . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–1
Service considerations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–1
Grounding guidelines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–2

Component replacement procedures  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–5
Service tag . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–5

Computer feet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–6
Battery. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–6
Hard drive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–8
WLAN module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–12
Memory module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–16
Optical drive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–18
Keyboard and switch cover. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–20
Maintenance and Service Guide iv



Contents
Speaker . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–24
Display assembly  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–25
Top cover  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–32
Bluetooth module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–34
System board. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–36
Fan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–38
RTC battery. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–40
Modem module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–42
Heat sink . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–44
Modem module cable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–48
Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4–49

5 Computer Setup

Computer Setup for computer models equipped with an AMD processor  . . . . . . . . . . . . . . . . . . . . . . . . .  5–1
Starting Computer Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–1
Using Computer Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–1
Computer Setup menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–3
File Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–3
Security Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–4
Diagnostics Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–4
System Configuration Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–5

Computer Setup for computer models equipped with an Intel processor  . . . . . . . . . . . . . . . . . . . . . . . . . .  5–7
Starting Computer Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–7
Using Computer Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–7
Computer Setup menus . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–8
File Menu  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–8
Security Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–9
Diagnostics Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–9
System Configuration Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5–10

6 Specifications

Computer specifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–1
14.0-in display specifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–2
Hard drive specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–3
DVD±RW and CD-RW SuperMulti Double-Layer Drive specifications . . . . . . . . . . . . . . . . . . . . . . . . . .  6–4
DVD-ROM Drive specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–5
System DMA specifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–6
System memory map specifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–7
System interrupt specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–8
System I/O address specifications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6–9
v Maintenance and Service Guide



Contents
7 Screw listing

Phillips PM2.0×6.0 captive screw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–1
Phillips PM2.5×11.0 captive screw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–2
Phillips PM3.0×4.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–3
Black Phillips PM2.5×4.0 screw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–4
Silver Phillips PM2.5×4.0 screw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–6
Slotted Torx T8M2.5×8.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–7
Phillips PM2.0×3.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–8
Phillips PM2.0×3.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–9
Phillips PM2.0×2.0 broadhead screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–10
Phillips PM2.0×3.0 broadhead screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–11
Phillips PM2.5×8.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–12
Phillips PM2.0×4.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–13
Phillips PM2.5×6.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–14
Phillips PM2.5×5.0 screw  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–16
Phillips PM2.5×9.0 captive screw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–17
Phillips PM2.0×5.0 captive screw . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7–19

8 Backup and recovery

Backup and recovery in Windows Vista . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–1
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–1
Backing up your information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–2
Performing a recovery. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–3
Using the Windows recovery tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–3
Using f11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–4
Using a Windows Vista operating system DVD (purchased separately) . . . . . . . . . . . . . . . . . . . . . . .  8–4

Backup and recovery in Windows XP . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–5
Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–5
Backing up your information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–5
Performing a recovery. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8–6

9 Connector pin assignments

Audio-in (microphone). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9–1
Audio-out (headphone)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9–1
External monitor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9–2
RJ-11 (modem). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9–3
RJ-45 (network) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9–3
Universal Serial Bus. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9–4
Maintenance and Service Guide vi



Contents
10Power cord set requirements

Requirements for all countries and regions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10–1
Requirements for specific countries and regions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10–2

11Recycling

Battery  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11–1
Display . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11–1

Index
vii Maintenance and Service Guide



1
Product description

Category Description
Compaq 516 
Notebook PC

Compaq 515 
Notebook PC

Compaq 511 
Notebook PC

Compaq 510 
Notebook PC

Product Name Compaq 516 Notebook PC x

Compaq 515 Notebook PC x

Compaq 511 Notebook PC x

Compaq 510 Notebook PC x

Processors AMD® processors:

■ Turion™ RM-74 2.20-GHz 
processor, 1-MB L2 Cache

■ Turion RM-72 2.10-GHz 
processor, 1-MB L2 Cache

■ Athlon™ QL-64 2.10-GHz 
processor, 1-MB L2 Cache

■ Athlon QL-62 2.00-GHz 
processor, 1-MB L2 Cache

■ Sempron™ SI-42 2.10-GHz 
processor, 512-KB L2 Cache

x x

Intel® processors:

■ Intel Core™2 Duo T5870 
2.00-GHz processor, 2-MB L2 
cache, 800-MHz front side bus 
(FSB)

■ Intel Celeron™ 560 2.13-GHz 
processor, 1-MB L2 cache, 
533-MHz FSB

■ Intel Celeron 550 2.00-GHz 
processor, 1-MB L2 cache, 
533-MHz FSB

■ Intel Celeron Dual-Core T1500 
1.86-GHz processor, 512-KB 
L2 cache, 533-MHz FSB

x x

(Continued)
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Product description
Chipset AMD with graphics subsystem 
with discrete memory: RX781

x

AMD with graphics subsystem 
with UMA memory: RS780MN

x

Intel with graphics subsystem with 
discrete memory: PM965

x

Intel with graphics subsystem with 
UMA memory and processor with 
up to 800-MHz FSB: GME965

x

Intel with graphics subsystem with 
UMA memory and processor with 
up to 533-MHz FSB: GLE960

x

Southbridge: ICH8m x x

Graphics AMD M92S2-LP (ATI Mobile 
Radeon™ HD 4330) discrete 
graphics with Hypermemory 
support, 256 MB DDR2
(64 MB × 16 × 2)

x x

AMD Universal Memory 
Architecture (UMA) graphics 
(ATI Radeon HD 3200) integrated 
with shared video memory 
(dynamically allocated)

x

Intel UMA graphics (Mobile Intel 
GMA X3100) integrated with 
shared video memory 
(dynamically allocated)

x

Panel ■ 14.0-in, high-definition (HD, 
1366 × 768), AntiGlare, 
light-emitting diode (LED) 
display assembly with webcam

x x x x

■ 14.0-in, HD (1366 × 768), 
AntiGlare, 
LED display assembly

x x x x

■ 14.0-in, HD (1366 × 768), 
BrightView, 
LED display assembly 
with webcam

x x x x

■ 14.0-in, HD (1366 × 768), 
BrightView, 
LED display assembly

x x x x

■ 14.0-in, HD (1366 × 768), 
EMPC BrightView, 
LED display assembly 
with webcam

x x x x

■ Supports privacy filter x x x x

■ All display assemblies include 
2 WLAN antennas

x x x x

(Continued)

Category Description
Compaq 516 
Notebook PC

Compaq 515 
Notebook PC

Compaq 511 
Notebook PC

Compaq 510 
Notebook PC
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Product description
Memory 2 customer-accessible/upgradable 
memory module slots
Supports dual-channel memory

x x x x

Supports the following 
configurations at 800 MHz and 
667 MHz:

■ 8192-MB total system memory 
(4096 × 2, dual-channel)

■ 4096-MB total system memory 
(2048 × 2, dual-channel)

■ 4096-MB total system memory 
(4096 × 1)

■ 3072-MB total system memory 
(2048 + 1024, dual-channel)

■ 2560-MB total system memory 
(2048 + 512, dual-channel)

■ 2048-MB total system memory 
(1024 × 2, dual-channel)

■ 2048-MB total system memory 
(2048 × 1)

■ 1536-MB total system memory 
(1024 + 512, dual-channel)

■ 1024-MB total system memory 
(512 × 2, dual-channel)

■ 1024-MB total system memory 
(1024 × 1)

■ 512-MB total system memory 
(512 × 1)

(Continued)

Category Description
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Product description
Memory 
(continued)

Supports the following 
configurations at 667 MHz:

■ 4096-MB total system memory 
(2048 × 2, dual-channel, only 
on GME965 and PM965 
system boards)

■ 4096-MB total system memory 
(4096 × 1, only on GME965 
and PM965 system boards)

■ 3072-MB total system memory 
(2048 + 1024, dual-channel, 
only on GME965 and PM965 
system boards)

■ 2560-MB total system memory 
(2048 + 512, dual-channel, only 
on GME965 and PM965 
system boards)

■ 2048-MB total system memory 
(1024 × 2, dual-channel)

■ 2048-MB total system memory 
(2048 × 1)

■ 1536-MB total system memory 
(1024 + 512, dual-channel)

■ 1024-MB total system memory 
(512 × 2, dual-channel)

■ 1024-MB total system memory 
(1024 × 1)

■ 512-MB total system memory 
(512 × 1)

x x x x

Hard drives Supports 9.50-mm, 6.35-cm 
(2.50-in) hard drives
Supports HP DriveGuard 
Hard Drive Protection
Customer-accessible
Serial ATA (SATA)
Supports the following hard 
drives:

■ 500-GB, 5400-rpm

■ 320-GB, 5400-rpm

■ 250-GB, 7200- and 5400-rpm

■ 160-GB, 7200- and 5400-rpm

x x x x

(Continued)

Category Description
Compaq 516 
Notebook PC

Compaq 515 
Notebook PC

Compaq 511 
Notebook PC

Compaq 510 
Notebook PC
1–4 Maintenance and Service Guide



Product description
Optical drives 12.7-mm tray load
Serial ATA (SATA)
Fixed (removal of 1 screw 
required)
Customer-accessible
Parallel ATA
Supports no-optical-drive option
Supports the following drives: 

■ DVD±RW and CD-RW 
SuperMulti Double-Layer Drive 
with LightScribe

■ 8X DVD-ROM Drive

x x x x

Microphone Integrated IDT92HD75 
microphone

x x x x

Audio Single mono speaker x x x x

Headphone jack x x x x

Microphone jack x x x x

Webcam Integrated 2-megapixel webcam 
with fixed focus

x x x x

Modem 56k, v.92 data/fax modem x x x x

Supports no modem option x x x x

Ethernet Marvell 88E8042 10/100 network 
interface card (NIC)

x x x x

S3/S4/S5 wake on LAN
(AC mode only)

x x x x

Power 
requirements

90-W AC adapter x x

65-W AC adapter x x

6-cell, 2.20-Ah (47-Wh) Li-ion 
battery

x x x x

(Continued)

Category Description
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Product description
Wireless Integrated WLAN options by way 
of wireless module
2 wireless antennas built into 
display assembly
Supports no-WLAN option
Support for the following WLAN 
formats:

■ Broadcom 4322AGN 
802.11a/b/g/n WLAN module 
with Bluetooth®

■ Broadcom 4322AGN 
802.11a/b/g/n WLAN module

■ Broadcom 4312G 802.11a/b/g 
WLAN module with Bluetooth

■ Broadcom 4312G 802.11a/b/g 
WLAN module

x x x x

■ Intel PRO/wireless 3945 
802.11a/b/g WLAN module with 
Bluetooth

■ Intel PRO/wireless 3945 
802.11a/b/g WLAN module

■ Intel PRO/wireless 3945 
802.11b/g WLAN module with 
Bluetooth (for use in Jordan, 
Kuwait, and the United Arab 
Emirates only)

■ Intel PRO/wireless 3945 
802.11b/g WLAN module 
(for use in Jordan, Kuwait, and
the United Arab Emirates only)

x x

External media 
cards

One ExpressCard slot, supporting 
optional ExpressCard/34 cards
SD Card Reader supporting 
MultiMediaCard (MMC), 
MultiMediaCard 4.2 (MMC Plus, 
including MMC Plus HC), Secure 
Digital (SD) Memory Card, Secure 
Digital High Capacity (SDHC) 
Memory Card, and Secure Digital 
High Speed (SDHS) Memory Card

x x x x

Ports Audio-in (mono microphone) x x x x

Audio-out (stereo headphone) x x

Multi-pin AC power x x x x

RJ-45 (Ethernet, includes link and 
activity lights)

x x x x

RJ-11 (modem) x x x x

USB v. 2.0 (3) x x x x

VGA (Dsub 15-pin) supporting 
1600 × 1200 external resolution at 
75 GHz

x x x x

(Continued)
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Product description
Keyboard/
pointing 
devices

Keyboard
TouchPad with 2 TouchPad 
buttons
Supports 2-way scroll 
Taps enabled as default 

x x x x

Security Security cable slot x x x x

Operating 
system

Preinstalled with MS Basics:

■ Windows Vista® Home Basic 
(32 bit, English and 
Japanese only)

x x x x

■ Windows Vista Business 
(32 bit, English 
and Japanese only)

x x x x

■ Windows Vista Business 
(32 bit, Japanese only)

x x x x

Preinstalled with MS Office:

■ Windows Vista Basic (32 bit) 
with Office 2007 Ready

x x x x

■ Windows Vista Home Basic 
(32 bit) with Office 2007 Ready 
without Powerpoint 
(Japanese only)

x x x x

■ Windows Vista Home Basic 
(32 bit) with Office 2007 
Personal with Powerpoint 
(Japanese only)

x x x x

■ Windows Vista Home Basic 
(32 bit) with Office 2007 
Professional (Japanese only)

x x x x

■ Windows Vista Business 
(32 bit) with Office 2007 Ready

x x x x

■ Windows Vista Business 
(32 bit) with Office 2007 
Personal without Powerpoint 
(Japanese only)

x x x x

■ Windows Vista Business 
(32 bit) with Office 2007 
Personal with Powerpoint 
(Japanese only)

x x x x

■ Windows Vista Business 
(32 bit) with Office 2007 
Professional (Japanese only)

x x x x

■ Windows Vista Business 
(32 bit, with Windows XP Pro 
images) with Office 2007 
Ready

x x x x

(Continued)
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Product description
Operating 
system 
(continued)

Preinstalled with MS Office 
(continued):

■ Windows Vista Business 
(32 bit, with Windows XP Pro 
images) with Office 2007 
Personal (Japanese only)

x x x x

■ Windows Vista Business 
(32 bit, with Windows XP Pro 
images) with Office 2007 
Personal with Powerpoint 
(Japanese only)

x x x x

■ Windows Vista Business 
(32 bit, with Windows XP Pro 
images) with Office 2007 
Professional (Japanese only)

x x x x

Preinstalled:

■ FreeDOS x x x x

■ Red Flag Linux
(People’s Republic of China 
only)

x x x x

Restore Media:

■ Windows Vista Basic (32 bit)

x x x x

■ Windows Vista Business 
(32 bit)

x x x x

■ Windows Vista Business 
(64 bit)

x x x x

■ Windows XP Pro x x x x

■ DRDVD Windows Vista x x x x

■ DRDVD Windows XP Pro x x x x

■ SRDVD SUSE Linux x x

■ Office Ready DVD x x x x

■ Red Flag Linux
(People’s Republic of China 
only)

x x x x

Certified:

■ Microsoft® WHQL

x x x x

■ SuSE Linux x x x x

Serviceability End-user replaceable parts:
AC adapter
Battery (system)
Hard drive
Memory modules
Optical drive
WLAN module

x x x x

Category Description
Compaq 516 
Notebook PC

Compaq 515 
Notebook PC

Compaq 511 
Notebook PC

Compaq 510 
Notebook PC
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2
External component identification

Top components

Display components

Item Component Description

(1) Wireless antennas (select 
models only)

On select computer models, at least 2 antennas send and receive signals 
from one or more wireless devices.

✎ The antennas are not visible from the outside of the computer. 
For optimal transmission, keep the areas immediately around the 
antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, 
Safety and Environmental Notices that applies to your country or region. 
These notices are located in Help and Support.

(2) Webcam light (select models only) On: The webcam is in use.

(3) Webcam (select models only) Records video and captures still photographs.

(Continued)
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External component identification
(4) Speaker Produces sound.

(5) Audio-out (headphone) jack Produces sound when connected to optional powered stereo speakers, 
headphones, ear buds, a headset, or television audio.

✎ When a device is connected to the headphone jack, the computer 
speakers are disabled.

(6) Internal microphone Records sound.

(7) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array 
microphone, or monaural microphone.

Item Component Description
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External component identification
Buttons, switch, and speaker

Item Component Description

(1) Internal display switch Turns off the display if the panel lid is closed while the power is on.

(2) Wireless button Turns the wireless feature on or off but does not establish a 
wireless connection.

✎ You must set up or access a wireless network to establish a 
wireless connection.

(3) Power button ■ When the computer is off, press the button to turn on the computer.

■ When the computer is on, press the button to shut down the computer.

■ When the computer is in the Sleep state, press the button briefly to 
exit Sleep.

■ When the computer is in Hibernation, press the button briefly to 
exit Hibernation.

If the computer has stopped responding and Windows shutdown procedures 
are ineffective, press and hold the power button for at least 5 seconds to turn 
off the computer.
To learn more about your power settings, select Start > Control Panel > 
System and Maintenance > Power Options.

(4) Speaker Produces sound.
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External component identification
Keys

Item Component Description

(1) esc key Displays system information when pressed in combination with the fn key.

(2) fn key Executes frequently used system functions when pressed in combination with 
a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in combination with 
the fn key.
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External component identification
Lights

Item Component Description

(1) Caps lock light On: Caps lock is on.

(2) Wireless light ■ Blue: An integrated wireless device, such as a wireless local area network 
(WLAN) device and/or a Bluetooth® device, is on.

■ Amber: All wireless devices are off.

(3) Power light ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state.

■ Off: The computer is off or in Hibernation.
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External component identification
Pointing devices

Item Component Description

(1) TouchPad* Moves the pointer and selects or activates items on the screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel > 
Hardware and Sound > Mouse.
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External component identification
Front components

Item Component Description

(1) Audio-out (headphone) jack Produces sound when connected to optional powered stereo speakers, 
headphones, ear buds, a headset, or television audio.

✎ When a device is connected to the headphone jack, the computer 
speakers are disabled.

(2) Internal microphone Records sound.

(3) Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array 
microphone, or monaural microphone.

(4) SD Card Reader Supports the following optional digital card formats:

■ MultiMediaCard (MMC)

■ MultiMediaCard 4.2 (MMC Plus, including MMC Plus HC)

■ Secure Digital (SD) Memory Card

■ Secure Digital High Capacity (SDHC) Memory Card

■ Secure Digital High Speed (SDHS) Memory Card
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External component identification
Right-side components

Item Component Description

(1) Optical drive Reads optical discs and, on select models, also writes to optical discs.

(2) Optical drive light Blinking: The optical drive is being accessed.

(3) Security cable slot Attaches an optional security cable to the computer.

✎ The security cable is designed to act as a deterrent, but it may not 
prevent the computer from being mishandled or stolen.
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External component identification
Left-side components

Item Component Description

(1) ExpressCard slot Supports optional ExpressCards.

(2) RJ-11 (modem) jack (select 
models only)

Connects a modem cable.

(3) Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(4) External monitor port Connects an external VGA monitor or projector.

(5) Battery light ■ Amber: A battery is charging.

■ Turquoise: A battery is close to full charge capacity.

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly.

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source the light stays off until the 
battery reaches a low battery level.

(6) Power connector Connects an AC adapter.

(7) RJ-45 (network) jack Connects a network cable.

(8) USB ports (3) Connect optional USB devices.
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External component identification
Bottom components

Item Component Description

(1) Battery bay Holds the battery.

(2) Battery release latches (2) Release the battery from the battery bay.

(3) Vents (4) Enable airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

(4) Memory module compartment Contains the memory module slots.

(5) WLAN module compartment Contains the wireless LAN module slot.

Ä To prevent an unresponsive system, replace the wireless module only 
with a wireless module authorized for use in the computer by the 
governmental agency that regulates wireless devices in your country. 
If you replace the module and then receive a warning message, remove 
the module to restore computer functionality, and then contact technical 
support through Help and Support.

(6) Hard drive bay Holds the hard drive.
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3
Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

1 Product name This is the product name affixed to the front of the computer.

2 Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

3 Part number/Product number (p/n) This number provides specific information about the product’s 
hardware components. The part number helps a service 
technician to determine what components and parts are needed.

4 Model description This is the alphanumeric identifier used to locate documents, 
drivers, and support for the computer.

5 Warranty period This number describes the duration of the warranty period for 
the computer.
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Illustrated parts catalog
Computer major components
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Illustrated parts catalog
Item Description Spare Part Number

(1) 14.0-in, SVA, HD, LED display assembly (includes 2 WLAN antenna transceivers and cables, nameplate, and logo):

For use only on computer models equipped with an AMD processor:

■ AntiGlare display assembly for use only on computer models equipped with a webcam 572524-001

■ AntiGlare display assembly for use only on computer models not equipped with 
a webcam

572523-001

■ BrightView display assembly for use only on computer models equipped with a webcam 572526-001

■ BrightView display assembly for use only on computer models not equipped with 
a webcam

572525-001

For use only on computer models equipped with an Intel processor:

■ AntiGlare display assembly for use only on computer models equipped with a webcam 538416-001

■ AntiGlare display assembly for use only on computer models not equipped with 
a webcam

538415-001

■ BrightView display assembly for use only on computer models equipped with a webcam 538419-001

■ BrightView display assembly for use only on computer models not equipped with 
a webcam

538418-001

✎ See “Display assembly subcomponents” on page 3-10 for display assembly internal component spare 
part information.

(2) Switch cover (includes power button board and cable) 538451-001

(3) Keyboard (includes keyboard cable):

■ For use in Belgium 539682-A41

■ For use in Brazil 539682-201

■ For use in Bulgaria 539682-261

■ For use in the Czech Republic 539682-221

■ For use in Denmark 539682-081

■ For use in France 539682-051

■ For use in French Canada 539682-121

■ For use in Germany 539682-041

■ For use in Greece 539682-DJ1

■ For use in Hungary 539682-211

■ For use in Iceland 539682-DD1

■ For use in Israel 539682-BB1

■ For use in Italy 539682-061

(Continued)
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Illustrated parts catalog
(3) Keyboard:

■ For use in Japan 539682-291

■ For use in Latin America 539682-161

■ For use in the Netherlands 539682-B31

■ For use in Norway 539682-091

■ For use in Portugal 539682-131

■ For use in Russia 539682-251

■ For use in Saudi Arabia 539682-171

■ For use in Slovakia 539682-231

■ For use in Slovenia 539682-BA1

■ For use in South Korea 539682-AD1

■ For use in Spain 539682-071

■ For use in Sweden and Finland 539682-B71

■ For use in Switzerland 539682-BG1

■ For use in Taiwan 539682-AB1

■ For use in Thailand 539682-281

■ For use in Turkey 539682-141

■ For use in the United Kingdom 539682-031

■ For use in the United States 539682-001

(4) Speaker 538453-001

(5) Top cover (includes TouchPad button board and cable and TouchPad board and cable) 538446-001

Plastics Kit, includes: 538450-001

(6a) ExpressCard slot bezel

(6b) Wireless module compartment cover

(6c) Hard drive cover

(6d) Memory module compartment cover

(Not illustrated: Optical drive bay bezel and RJ-11 connector cover)

✎ See “Plastics Kit” on page 3-9 for more Plastics Kit spare part information.

(Continued)

Item Description Spare Part Number
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Illustrated parts catalog
(7) System board (includes replacement thermal material):

For use only on computer models equipped with an AMD processor:

■ For use only on computer models equipped with a graphics subsystem with 
discrete memory

538392-001

■ For use only on computer models equipped with a graphics subsystem with 
UMA memory

538391-001

For use only on computer models equipped with an Intel processor:

■ For use only on computer models equipped with a graphics subsystem with 
discrete memory

538408-001

■ GL system board use only on computer models equipped with a graphics subsystem with 
UMA memory

538407-001

■ GM system board for use only on computer models equipped with a graphics subsystem 
with UMA memory

538409-001

Cable Kit, includes: 538465-001

(8a) Bluetooth module cable

(8b) Modem module cable (includes RJ-11 connector)

(9) Modem module

✎ The modem module spare part kit does not include a modem module cable. The modem module cable is 
included in the Cable Kit, spare part number 538465-001.

For use in all countries and regions except Australia and New Zealand 510100-001

For use only in Australia and New Zealand 510100-011

(10) Bluetooth module

Full-sized Bluetooth module 398393-002

Reduced form factor Bluetooth module 537921-001

✎ The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module cables 
are included in the Cable Kit, spare part number 538465-001.

(11) RTC battery 449137-001

(12) Processor (includes replacement thermal material):

AMD Turion RM-74 2.20-GHz processor, 1-MB L2 Cache 507979-001

AMD Turion RM-72 2.10-GHz processor, 1-MB L2 Cache 507978-001

AMD Athlon QL-64 2.10-GHz processor, 1-MB L2 Cache 506053-001

AMD Athlon QL-62 2.00-GHz processor, 1-MB L2 Cache 506052-001

AMD Sempron SI-42 2.10-GHz processor, 512-KB L2 Cache 508102-001

Intel Core2 Duo processors:

■ T5870 2.00-GHz processor (2-MB L2 cache, 800-MHz FSB) 535835-001

■ T1500 1.86-GHz processor (1-MB L2 cache, 800-MHz FSB) 576209-001

Intel Celeron processors:

■ 560 2.13-GHz processor (1-MB L2 cache, 533-MHz FSB) 576208-001

■ 550 2.00-GHz processor (1-MB L2 cache, 533-MHz FSB) 576207-001

(Continued)

Item Description Spare Part Number
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Illustrated parts catalog
(13) Heat sink (includes replacement thermal material):

For use only on computer models equipped with an AMD processor:

■ For use only on computer models equipped with a graphics subsystem with 
discrete memory

538459-001

■ For use only on computer models equipped with a graphics subsystem with 
UMA memory

538456-001

For use only on computer models equipped with an Intel processor:

■ For use only on computer models equipped with a graphics subsystem with 
discrete memory

538458-001

■ For use only on computer models equipped with a graphics subsystem with 
UMA memory

538457-001

(14) Fan 538455-001

(15) Base enclosure (includes seven rubber feet) 538444-001

Rubber Feet Kit (not illustrated, includes seven feet and eight display bezel screw covers) 538448-001

(16) Battery:

6-cell, 2.20-Ah (47-Wh) Li-ion battery for use only on computer models equipped with an 
AMD processor

572186-001

6-cell, 2.20-Ah (47-Wh) Li-ion battery for use only on computer models equipped with an 
Intel processor

572189-001

(17) WLAN module:

802.11a/b/g/n WLAN module for use with all computer models:

■ Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Canada, 
the Cayman Islands, Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

518434-001

■ Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, 
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, 
Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, 
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, 
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, 
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, 
Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-002

(Continued)
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(17) 802.11a/b/g WLAN modules for use on all computer models:

■ Broadcom 4312G 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, 
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

■ Broadcom 4312G 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, 
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, 
Cameroon, Cape Verde, the Central African Republic, Chad, Colombia, Comoros, 
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, 
Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, 
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, 
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, 
the People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, 
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, 
Thailand, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, 
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

802.11a/b/g WLAN modules for use only on computer models equipped with an Intel processor:

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Antigua and Barbuda, 
Argentina, Australia, the Bahamas, Barbados, Brunei, Canada, Chile, 
the Dominican Republic, Guam, Guatemala, Hong Kong, India, Indonesia, Malaysia, 
Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United States, 
and Vietnam

451861-001

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Aruba, Austria, 
Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the Cayman Islands, Colombia, 
Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El Salvador, Estonia, Finland, 
France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Italy, Jordan, Latvia, 
Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, Montenegro, 
the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Romania, Russia, 
Serbia, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, 
Switzerland, Turkey, the United Kingdom, and Uzbekistan

451861-002

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Ecuador, Haiti, Honduras, 
Pakistan, the People's Republic of China, Peru, Qatar, Uruguay, and Venezuela

451861-003

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Japan 407575-291

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in South Korea 409280-004

(Continued)

Item Description Spare Part Number
Maintenance and Service Guide 3–7



Illustrated parts catalog
(18) Hard drive (includes hard drive connector and hard drive bracket):

For use only on computer models equipped with an AMD processor:

■ 500-GB, 5400-rpm 538405-001

■ 320-GB, 5400-rpm 538404-001

■ 250-GB, 7200-rpm 575199-001

■ 250-GB, 5400-rpm 538403-001

■ 160-GB, 7200-rpm 575198-001

■ 160-GB, 5400-rpm 538402-001

For use only on computer models equipped with an Intel processor:

■ 500-GB, 5400-rpm 538440-001

■ 320-GB, 5400-rpm 538439-001

■ 250-GB, 7200-rpm 575197-001

■ 250-GB, 5400-rpm 538438-001

■ 160-GB, 7200-rpm 575196-001

■ 160-GB, 5400-rpm 538437-001

(19) Optical drive (includes bezel and bracket):

For use only on computer models equipped with an AMD processor:

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 538406-001

■ DVD-ROM Drive 575200-001

For use only on computer models equipped with an Intel processor:

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 538442-001

■ DVD-ROM Drive 538441-001

(20) Memory modules:

For use only on computer models equipped with an AMD processor:

■ 2048-MB (800-MHz, DDR2) 538401-001

■ 1024-MB (800-MHz, DDR2) 538400-001

■ 512-MB (800-MHz, DDR2) 538399-001

■ 1024-MB (667-MHz, DDR2) 538397-001

■ 512-MB (667-MHz, DDR2) 538396-001

For use only on computer models equipped with an Intel processor:

■ 2048-MB (800-MHz, DDR2) 538436-001

■ 1024-MB (800-MHz, DDR2) 538435-001

■ 512-MB (800-MHz, DDR2) 538434-001

■ 2048-MB (667-MHz, DDR2) 538433-001

■ 1024-MB (667-MHz, DDR2) 538432-001

■ 512-MB (667-MHz, DDR2) 538431-001

Item Description Spare Part Number
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Plastics Kit

Item Description Spare part number

Plastics Kit: 538450-001

(1) ExpressCard slot bezel

(2) Wireless module compartment cover

(3) Hard drive cover (includes three captive screws, secured by C-clips)

(4) Memory module compartment cover (includes one captive screw, secured by a C-clip)

(5) RJ-11 connector cover

(6) Optical drive bay bezel
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Display assembly subcomponents

Item Description Spare part number

(1) Display bezel

For use only on computer models equipped with a webcam 538426-001

For use only on computer models not equipped with a webcam 538425-001

(2) Webcam module 538443-001

(3) Display hinges 538461-001

Display Cable Kit, includes: 538463-001

(4a) Webcam module cable

(4b) Display panel cable

(4c) Wireless antenna cable

(5) Display enclosure 538429-001
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Mass storage devices

Item Description Spare part number

(1) Hard drive (includes hard drive connector and hard drive bracket):

For use only on computer models equipped with an AMD processor:

■ 500-GB, 5400-rpm 538405-001

■ 320-GB, 5400-rpm 538404-001

■ 250-GB, 7200-rpm 575199-001

■ 250-GB, 5400-rpm 538403-001

■ 160-GB, 7200-rpm 575198-001

■ 160-GB, 5400-rpm 538402-001

For use only on computer models equipped with an Intel processor:

■ 500-GB, 5400-rpm 538440-001

■ 320-GB, 5400-rpm 538439-001

■ 250-GB, 7200-rpm 575197-001

■ 250-GB, 5400-rpm 538438-001

■ 160-GB, 7200-rpm 575196-001

■ 160-GB, 5400-rpm 538437-001

(2) Optical drive (includes bezel and bracket):

For use only on computer models equipped with an AMD processor:

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 538406-001

■ DVD-ROM Drive 575200-001

For use only on computer models equipped with an Intel processor:

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 538442-001

■ DVD-ROM Drive 538441-001
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Miscellaneous parts

Description Spare part number

AC adapters:

■ 90-W PFC HP Smart Adapter 432309-001

■ 65-W PFC HP Smart Adapter 417220-001

Power cords:

■ For use in Argentina 490370-D01

■ For use in Australia 490371-111

■ For use in Brazil 490371-201

■ For use in Europe, the Middle East, and Africa 490371-021

■ For use in India 490371-D61

■ For use in Israel 490371-BB1

■ For use in Italy 490371-061

■ For use in Japan 490371-291

■ For use in the People’s Republic of China 490371-AA1

■ For use in South Africa 490371-AR1

■ For use in South Korea 490371-AD1

■ For use in Switzerland 490371-AG1

■ For use in Taiwan 490371-AB1

■ For use in the United Kingdom and Singapore 490371-031

■ For use in the United States 490371-001

Screw Kit

■ Phillips PM3.0 × 4.0 screws

■ Phillips PM2.5 × 11.0 captive screws

■ Phillips PM2.5 × 9.0 captive screws

■ Phillips PM2.5 × 8.0 screws

■ Phillips PM2.5 × 6.0 screws

■ Phillips PM2.5 × 5.0 screws

■ Phillips PM2.5 × 4.0 screws

■ Phillips PM2.0 × 6.0 captive screws

■ Phillips PM2.0 × 5.0 captive screws

■ Phillips PM2.0 × 3.0 broadhead screws

■ Phillips PM2.0 × 3.0 screws

■ Phillips PM2.0 × 2.0 broadhead screws

■ Torx T8M2.5 × 8.0 screws

538449-001
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Sequential part number listing

Spare part number Description

398393-002 Full-sized Bluetooth module (Bluetooth module cable not included. The Bluetooth module cables are 
included in the Cable Kit, spare part number 538465-001.)

407575-291 Intel PRO/wireless 3945 802.11a/b/g WLAN module for use only on computer models equipped with 
an Intel processor in Japan

409280-004 Intel PRO/wireless 3945 802.11a/b/g WLAN module for use only on computer models equipped with 
an Intel processor in South Korea

417220-001 65-W PFC HP Smart Adapter

432309-001 90-W PFC HP Smart Adapter

449137-001 RTC battery

451861-001 Intel PRO/wireless 3945 802.11a/b/g WLAN module for use only on computer models equipped with 
an Intel processor in Antigua and Barbuda, Argentina, Australia, the Bahamas, Barbados, Brunei, 
Canada, Chile, the Dominican Republic, Guam, Guatemala, Hong Kong, India, Indonesia, Malaysia, 
Mexico, New Zealand, Panama, Paraguay, Saudi Arabia, Taiwan, the United States, and Vietnam

451861-002 Intel PRO/wireless 3945 802.11a/b/g WLAN module for use only on computer models equipped with 
an Intel processor in Aruba, Austria, Azerbaijan, Bahrain, Belgium, Bermuda, Brazil, Bulgaria, 
the Cayman Islands, Colombia, Croatia, Cyprus, the Czech Republic, Denmark, Egypt, El Salvador, 
Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland, Ireland, Italy, Jordan, Latvia, 
Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, Montenegro, the Netherlands, 
Norway, Oman, the Philippines, Poland, Portugal, Romania, Russia, Serbia, Singapore, Slovakia, 
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, 
and Uzbekistan

451861-003 Intel PRO/wireless 3945 802.11a/b/g WLAN module for use only on computer models equipped with 
an Intel processor in Ecuador, Haiti, Honduras, Pakistan, the People's Republic of China, Peru, 
Qatar, Uruguay, and Venezuela

490371-001 Power cord for use in the United States

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom and Singapore

490371-061 Power cord for use in Italy

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People’s Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

504593-003 Broadcom 4312G 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

(Continued)
Maintenance and Service Guide 3–13



Illustrated parts catalog
504593-004 Broadcom 4312G 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's 
Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, 
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the 
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South 
Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, 
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab 
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, 
Zambia, and Zimbabwe

506052-001 AMD Athlon QL-62 2.00-GHz processor (1-MB L2 cache, includes replacement thermal material)

506053-001 AMD Athlon QL-64 2.10-GHz processor (1-MB L2 cache, includes replacement thermal material)

507978-001 AMD Turion RM-72 2.10-GHz processor (1-MB L2 cache, includes replacement thermal material)

507979-001 AMD Turion RM-74 2.20-GHz processor (1-MB L2 cache, includes replacement thermal material)

508102-001 AMD Sempron SI-42 2.10-GHz processor (512-KB L2 cache, includes replacement thermal material)

510100-001 Modem module for use in all countries and regions except Australia and New Zealand

✎ The modem module spare part kit does not include a modem module cable. The modem 
module cable is included in the Cable Kit, spare part number 538465-001.

510100-011 Modem module for use only in Australia and New Zealand

✎ The modem module spare part kit does not include a modem module cable. The modem 
module cable is included in the Cable Kit, spare part number 538465-001.

518434-001 Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

(Continued)
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518434-002 Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, 
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, 
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, 
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, 
Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, 
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, 
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the People's 
Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, 
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the 
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South 
Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, 
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab 
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, 
Zambia, and Zimbabwe

535835-001 Intel Core2 Duo T5870 2.00-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement 
thermal material)

537921-001 Reduced form factor Bluetooth module (Bluetooth module cable not included. The Bluetooth module 
cables are included in the Cable Kit, spare part number 538465-001.)

538391-001 System board for use only on computer models equipped with an AMD processor and a graphics 
subsystem with UMA memory (includes replacement thermal material)

538392-001 System board for use only on computer models equipped with an AMD processor and a graphics 
subsystem with discrete memory (includes replacement thermal material)

538396-001 512-MB memory module (667-MHz, DDR2) for use only on computer models equipped with an 
AMD processor

538397-001 1024-MB memory module (667-MHz, DDR2) for use only on computer models equipped with an 
AMD processor

538399-001 512-MB memory module (800-MHz, DDR2) for use only on computer models equipped with an 
AMD processor

538400-001 1024-MB memory module (800-MHz, DDR2) for use only on computer models equipped with an 
AMD processor

538401-001 2048-MB memory module (800-MHz, DDR2) for use only on computer models equipped with an 
AMD processor

538402-001 160-GB, 5400-rpm hard drive for use only on computer models equipped with an AMD processor 
(includes hard drive connector and hard drive bracket)

538403-001 250-GB, 5400-rpm hard drive for use only on computer models equipped with an AMD processor 
(includes hard drive connector and hard drive bracket)

538404-001 320-GB, 5400-rpm hard drive for use only on computer models equipped with an AMD processor 
(includes hard drive connector and hard drive bracket)

538405-001 500-GB, 5400-rpm hard drive for use only on computer models equipped with an AMD processor 
(includes hard drive connector and hard drive bracket)

538406-001 DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe for use only on computer 
models equipped with an AMD processor (includes bezel and bracket)

(Continued)
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538407-001 GL system board use only on computer models equipped with an Intel processor and a graphics 
subsystem with UMA memory (includes replacement thermal material)

538408-001 System board for use only on computer models equipped with an Intel processor and a graphics 
subsystem with discrete memory (includes replacement thermal material)

538409-001 GM system board for use only on computer models equipped with an Intel processor and a graphics 
subsystem with UMA memory (includes replacement thermal material)

538415-001 14.0-in, SVA, HD, LED AntiGlare display assembly for use only on computer models equipped with an 
Intel processor but not a webcam (includes 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

538416-001 14.0-in, SVA, HD, LED AntiGlare display assembly for use only on computer models equipped with an 
Intel processor and with a webcam (includes 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

538418-001 14.0-in, SVA, HD, LED BrightView display assembly for use only on computer models equipped with 
an Intel processor but not a webcam (includes 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

538419-001 14.0-in, SVA, HD, LED BrightView display assembly for use only on computer models equipped with 
an Intel processor and with a webcam (includes 2 WLAN antenna transceivers and cables, 
nameplate, and logo)

538425-001 Display bezel for use only on computer models not equipped with a webcam

538426-001 Display bezel for use only on computer models equipped with a webcam

538429-001 Display enclosure

538431-001 512-MB memory module for use only on computer models equipped with an Intel processor 
(667-MHz, DDR2)

538432-001 1024-MB memory module for use only on computer models equipped with an Intel processor 
(667-MHz, DDR2)

538433-001 2048-MB memory module for use only on computer models equipped with an Intel processor 
(667-MHz, DDR2)

538434-001 512-MB memory module for use only on computer models equipped with an Intel processor 
(800-MHz, DDR2)

538435-001 1024-MB memory module for use only on computer models equipped with an Intel processor 
(800-MHz, DDR2)

538436-001 2048-MB memory module for use only on computer models equipped with an Intel processor 
(800-MHz, DDR2)

538437-001 160-GB, 5400-rpm hard drive for use only on computer models equipped with an Intel processor 
(includes hard drive connector and hard drive bracket)

538438-001 250-GB, 5400-rpm hard drive for use only on computer models equipped with an Intel processor 
(includes hard drive connector and hard drive bracket)

538439-001 320-GB, 5400-rpm hard drive for use only on computer models equipped with an Intel processor 
(includes hard drive connector and hard drive bracket)

538440-001 500-GB, 5400-rpm hard drive for use only on computer models equipped with an Intel processor 
(includes hard drive connector and hard drive bracket)

538441-001 DVD-ROM Drive for use only on computer models equipped with an Intel processor

538442-001 DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe for use only on computer 
models equipped with an Intel processor

538443-001 Webcam module

538444-001 Base enclosure (includes seven rubber feet)

(Continued)
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538446-001 Top cover (includes TouchPad on/off board and cable, TouchPad button board and cable, and 
TouchPad board and cable)

538448-001 Rubber Feet Kit (includes seven feet and eight display bezel screw covers)

538449-001 Screw Kit

538450-001 Plastics Kit

✎ See “Plastics Kit” on page 3-9 for Plastics Kit spare part information.

538451-001 Switch cover (includes power button board and cable)

538453-001 Speaker

538455-001 Fan

538456-001 Heat sink for use only on computer models equipped with an AMD processor and a graphics 
subsystem with UMA memory (includes replacement thermal material)

538457-001 Heat sink for use only on computer models equipped with an Intel processor and a graphics 
subsystem with UMA memory (includes replacement thermal material)

538458-001 Heat sink for use only on computer models equipped with an Intel processor and a graphics 
subsystem with discrete memory (includes replacement thermal material)

538459-001 Heat sink for use only on computer models equipped with an AMD processor and a graphics 
subsystem with discrete memory (includes replacement thermal material)

538461-001 Display hinges

538463-001 Display Cable Kit

✎ See “Display assembly subcomponents” on page 3-10 for display assembly internal 
component spare part information.

538465-001 Cable Kit

539682-001 Keyboard for use in the United States (includes keyboard cable)

539682-031 Keyboard for use in the United Kingdom (includes keyboard cable)

539682-041 Keyboard for use in Germany (includes keyboard cable)

539682-051 Keyboard for use in France (includes keyboard cable)

539682-061 Keyboard for use in Italy (includes keyboard cable)

539682-071 Keyboard for use in Spain (includes keyboard cable)

539682-081 Keyboard for use in Denmark (includes keyboard cable)

539682-091 Keyboard for use in Norway (includes keyboard cable)

539682-121 Keyboard for use in French Canada (includes keyboard cable)

539682-131 Keyboard for use in Portugal (includes keyboard cable)

539682-141 Keyboard for use in Turkey (includes keyboard cable)

539682-161 Keyboard for use in Latin America (includes keyboard cable)

539682-171 Keyboard for use in Saudi Arabia (includes keyboard cable)

539682-201 Keyboard for use in Brazil (includes keyboard cable)

539682-211 Keyboard for use in the Hungary (includes keyboard cable)

539682-221 Keyboard for use in the Czech Republic (includes keyboard cable)

539682-231 Keyboard for use in Slovakia (includes keyboard cable)

539682-251 Keyboard for use in Russia (includes keyboard cable)

(Continued)

Spare part number Description
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539682-261 Keyboard for use in Bulgaria (includes keyboard cable)

539682-281 Keyboard for use in Thailand (includes keyboard cable)

539682-291 Keyboard for use in Japan (includes keyboard cable)

539682-A41 Keyboard for use in Belgium (includes keyboard cable)

539682-AB1 Keyboard for use in Taiwan (includes keyboard cable)

539682-AD1 Keyboard for use in South Korea (includes keyboard cable)

539682-B31 Keyboard for use in the Netherlands (includes keyboard cable)

539682-B71 Keyboard for use in Sweden and Finland (includes keyboard cable)

539682-BA1 Keyboard for use in Slovenia (includes keyboard cable)

539682-BB1 Keyboard for use in Israel (includes keyboard cable)

539682-BG1 Keyboard for use in Switzerland (includes keyboard cable)

539682-DD1 Keyboard for use in Iceland (includes keyboard cable)

539682-DJ1 Keyboard for use in Greece (includes keyboard cable)

572186-001 6-cell, 2.20-Ah (47-Wh) Li-ion battery for use only on computer models equipped with an 
AMD processor

572189-001 6-cell, 2.20-Ah (47-Wh) Li-ion battery for use only on computer models equipped with an 
Intel processor

572523-001 14.0-in, SVA, HD, LED AntiGlare display assembly for use only on computer models equipped with an 
AMD processor but not a webcam (includes 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

572524-001 14.0-in, SVA, HD, LED AntiGlare display assembly for use only on computer models equipped with an 
AMD processor and with a webcam (includes 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

572525-001 14.0-in, SVA, HD, LED BrightView display assembly for use only on computer models equipped with 
an AMD processor but not a webcam (includes 2 WLAN antenna transceivers and cables, nameplate, 
and logo)

572526-001 14.0-in, SVA, HD, LED BrightView display assembly for use only on computer models equipped with 
an AMD processor and with a webcam (includes 2 WLAN antenna transceivers and cables, 
nameplate, and logo)

575196-001 160-GB, 7200-rpm hard drive for use only on computer models equipped with an Intel processor 
(includes hard drive connector and hard drive bracket)

575197-001 250-GB, 7200-rpm hard drive for use only on computer models equipped with an Intel processor 
(includes hard drive connector and hard drive bracket)

575198-001 160-GB, 7200-rpm hard drive for use only on computer models equipped with an AMD processor 
(includes hard drive connector and hard drive bracket)

575199-001 250-GB, 7200-rpm hard drive for use only on computer models equipped with an AMD processor 
(includes hard drive connector and hard drive bracket)

575200-001 DVD-ROM Drive for use only on computer models equipped with an AMD processor (includes bezel 
and bracket)

576207-001 Intel Celeron 550 2.00-GHz processor (1-MB L2 cache, 533-MHz FSB, includes replacement 
thermal material)

576208-001 Intel Celeron 560 2.13-GHz processor (1-MB L2 cache, 533-MHz FSB, includes replacement 
thermal material)

576209-001 Intel Core2 Duo T1500 1.86-GHz processor (1-MB L2 cache, 800-MHz FSB, includes replacement 
thermal material)

Spare part number Description
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Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures: 

■ Flat-bladed screwdriver

■ Phillips P0 screwdriver

■ Phillips P1 screwdriver

■ Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and 
assembly procedures. 

✎ As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) 
away from the work area to prevent damage. 

Plastic parts

Ä
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the 
plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

Ä
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the reassembly 
process. Improper cable placement can damage the computer. 

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the 
cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid 
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or 
snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily. 
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Drive handling

Ä
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the computer, damage to a 
drive, or loss of information, observe these precautions:
■ Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off or in 

Hibernation, turn the computer on, and then shut it down through the operating system. 
■ Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid touching the 

connector.
■ Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and be sure that the optical 

drive tray is closed.
■ Handle drives on surfaces covered with at least one inch of shock-proof foam. 
■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers. 
■ Avoid exposing a drive to temperature extremes or liquids. 
■ If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging and label 

the package “FRAGILE”.

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD 
contains enough power to alter device parameters or melt silicon junctions. 

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred. 

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a normal cycle. 
Or the device may function normally for a while, and then degrade in the internal layers, reducing its life 
expectancy. 

Ä
CAUTION: To prevent damage to the computer when you are removing or installing internal components, observe these 
precautions:
■ Keep components in their electrostatic-safe containers until you are ready to install them.
■ Use nonmagnetic tools. 
■ Before touching an electronic component, discharge static electricity by using the guidelines described in this section.
■ Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
■ If you remove a component, place it in an electrostatic-safe container.
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The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

ÄCAUTION: A product can be degraded by as little as 700 V. 

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment: 

■ To avoid hand contact, transport products in static-safe tubes, bags, or boxes. 

■ Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging. 

■ Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations. 

■ Place items on a grounded surface before removing items from their containers. 

■ Always be properly grounded when touching a component or assembly. 

■ Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam. 

■ Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment 
used for moving materials is wired to ground and that proper materials are selected to avoid static charging. 
When grounding is not possible, use an ionizer to dissipate electric charges. 

Typical electrostatic voltage levels 

Relative humidity 

Event 10% 40% 55% 

Walking across carpet 35,000 V 15,000 V 7,500 V 

Walking across vinyl floor 12,000 V 5,000 V 3,000 V 

Motions of bench worker 6,000 V 800 V 400 V 

Removing DIPS from plastic tube 2,000 V 700 V 400 V 

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V 

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V 

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V 

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V 
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Workstation guidelines

Follow these grounding workstation guidelines: 

■ Cover the workstation with approved static-shielding material. 

■ Use a wrist strap connected to a properly grounded work surface and use properly grounded tools and 
equipment. 

■ Use conductive field service tools, such as cutters, screwdrivers, and vacuums. 

■ When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials. 

■ Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam. 

■ Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items 
only at static-free workstations. 

■ Avoid contact with pins, leads, or circuitry. 

■ Turn off power and input signals before inserting or removing connectors or test equipment. 

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation. 

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly 
against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a 
wrist strap. 

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at 
standing workstations and are compatible with most types of shoes or boots. On conductive floors or 
dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the 
operator and ground. To be effective, the conductive strips must be worn in contact with the skin. 

The following grounding equipment is recommended to prevent electrostatic damage: 

■ Antistatic tape 

■ Antistatic smocks, aprons, and sleeve protectors 

■ Conductive bins and other assembly or soldering aids 

■ Nonconductive foam 

■ Conductive tabletop workstations with ground cords of one megohm resistance 

■ Static-dissipative tables or floor mats with hard ties to the ground 

■ Field service kits 

■ Static awareness labels 

■ Material-handling packages 

■ Nonconductive plastic bags, tubes, or boxes 

■ Metal tote boxes 

■ Electrostatic voltage levels and protective materials 

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level 

Antistatic plastic Bags 1,500 V 

Carbon-loaded plastic Floor mats 7,500 V 

Metallized laminate Floor mats 5,000 V 
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Component replacement procedures
This chapter provides removal and replacement procedures. 

There are as many as 71 screws, in 15 different sizes, that must be removed, replaced, or loosened when servicing 
the computer. Make special note of each screw size and location during removal and replacement. 

Service tag
When ordering parts or requesting information, provide the computer serial number and model number provided on 
the service tag.

Item Component Description

1 Product name This is the product name affixed to the front of the computer.

2 Serial number (s/n) This is an alphanumeric identifier that is unique to each product.

3 Part number/Product number (p/n) This number provides specific information about the product’s 
hardware components. The part number helps a service 
technician to determine what components and parts are needed.

4 Model description This is the alphanumeric identifier used to locate documents, 
drivers, and support for the computer.

5 Warranty period This number describes the duration of the warranty period for 
the computer.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part number 
538448-001. There are 7 rubber feet that attach to the base enclosure in the locations illustrated below.

Battery

Before removing the battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

Description Spare part number

6-cell, 2.20-Ah (47-Wh) Li-ion battery for use only on computer models equipped with an 
AMD processor

572186-001

6-cell, 2.20-Ah (47-Wh) Li-ion battery for use only on computer models equipped with an 
Intel processor

572189-001
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Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you. 

2. Slide the battery release latches 1 to release the battery. 

3. Remove the battery 2 from the computer. 

Install the battery by inserting it into the battery bay until you hear a click. 
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Hard drive

✎ The hard drive spare part kit includes a hard drive connector and hard drive bracket.

Before removing the hard drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

Description Spare part number

For use only on computer models equipped with an AMD processor:

■ 500-GB, 5400-rpm 538405-001

■ 320-GB, 5400-rpm 538404-001

■ 250-GB, 7200-rpm 575199-001

■ 250-GB, 5400-rpm 538403-001

■ 160-GB, 7200-rpm 575198-001

■ 160-GB, 5400-rpm 538402-001

For use only on computer models equipped with an Intel processor:

■ 500-GB, 5400-rpm 538440-001

■ 320-GB, 5400-rpm 538439-001

■ 250-GB, 7200-rpm 575197-001

■ 250-GB, 5400-rpm 538438-001

■ 160-GB, 7200-rpm 575196-001

■ 160-GB, 5400-rpm 538437-001
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Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0×6.0 captive screws 1 that secure the hard drive cover to the computer. 

3. Lift the right side 2 of the hard drive cover to detach it from the computer.

4. Remove the hard drive cover 3. The hard drive cover is included in the Plastics Kit, spare part number 
538450-001.
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5. Loosen the Phillips PM2.5×11.0 captive screw 1 that secures the hard drive in the hard drive bay.

6. Grasp the Mylar tab 2 on the hard drive and slide the hard drive 3 to the left.

7. Remove the hard drive 4 from the hard drive bay. 
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8. If it is necessary to replace the hard drive bracket, follow these steps:

a. Remove the two Phillips PM3.0×4.0 screws 1 from each side of the hard drive. 

b. Lift the bracket 2 straight up to remove it from the hard drive. 

Reverse this procedure to reassemble and install the hard drive. 
Maintenance and Service Guide 4–11



Removal and replacement procedures
WLAN module

Description Spare part number

802.11a/b/g/n WLAN module for use with all computer models:

■ Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Canada, the Cayman Islands, 
Guam, Puerto Rico, the United States, and the U.S. Virgin Islands

518434-001

■ Broadcom 4322AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, 
Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, 
the Central African Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, Croatia, 
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, 
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, 
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, 
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, 
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, 
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, 
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, 
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, 
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, 
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, 
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, 
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, 
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, 
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-002

(Continued)
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802.11a/b/g WLAN modules for use on all computer models:

■ Broadcom 4312G 802.11a/b/g WLAN module for use in Canada, the Cayman Islands, Guam, 
Puerto Rico, the United States, and the U.S. Virgin Islands

504593-003

■ Broadcom 4312G 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, 
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, 
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, 
the Central African Republic, Chad, Colombia, Comoros, the Congo, Costa Rica, Croatia, 
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, 
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, 
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, 
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, 
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Japan, Jordan, 
Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, 
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, 
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, 
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, 
the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, 
Panama, Papua New Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, 
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, 
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, 
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, 
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, 
Suriname, Swaziland, Sweden, Switzerland, Syria, Taiwan, Tajikistan, Tanzania, Thailand, Togo, 
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, 
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

504593-004

802.11a/b/g WLAN modules for use only on computer models equipped with an Intel processor:

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Antigua and Barbuda, Argentina, 
Australia, the Bahamas, Barbados, Brunei, Canada, Chile, the Dominican Republic, Guam, 
Guatemala, Hong Kong, India, Indonesia, Malaysia, Mexico, New Zealand, Panama, Paraguay, 
Saudi Arabia, Taiwan, the United States, and Vietnam

451861-001

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Aruba, Austria, Azerbaijan, 
Bahrain, Belgium, Bermuda, Brazil, Bulgaria, the Cayman Islands, Colombia, Croatia, Cyprus, 
the Czech Republic, Denmark, Egypt, El Salvador, Estonia, Finland, France, Georgia, Germany, 
Greece, Hungary, Iceland, Ireland, Italy, Jordan, Latvia, Lebanon, Liechtenstein, Lithuania, 
Luxembourg, Malta, Monaco, Montenegro, the Netherlands, Norway, Oman, the Philippines, 
Poland, Portugal, Romania, Russia, Serbia, Singapore, Slovakia, Slovenia, South Africa, Spain, 
Sri Lanka, Sweden, Switzerland, Turkey, the United Kingdom, and Uzbekistan

451861-002

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Ecuador, Haiti, Honduras, 
Pakistan, the People's Republic of China, Peru, Qatar, Uruguay, and Venezuela

451861-003

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in Japan 407575-291

■ Intel PRO/wireless 3945 802.11a/b/g WLAN module for use in South Korea 409280-004

Description Spare part number
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Before removing the WLAN module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

Remove the WLAN module:

Ä
CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless module authorized for use in 
the computer by the governmental agency that regulates wireless devices in your country or region. If you replace the module 
and then receive a warning message, remove the module to restore computer functionality, and then contact technical support 
through Help and Support.

1. Position the computer with the front toward you.

2. Lift the rear edge 1 of the wireless module compartment cover to detach it from the computer.

3. Remove the wireless module compartment cover 2. The wireless module compartment cover is included in the 
Plastics Kit, spare part number 538450-001.
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4. Disconnect the WLAN antenna cables 1 from the terminals on the WLAN module.

✎The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The white WLAN 
antenna cable is connected to the WLAN module “Aux” terminal. 

5. Remove the two Phillips PM2.5×4.0 screws 2 that secure the WLAN module to the computer. (The edge of the 
module opposite the slot rises away from the computer.)

6. Remove the WLAN module 3 by pulling the module away from the slot at an angle. 

✎WLAN modules are designed with a notch 4 to prevent incorrect insertion of the WLAN module into 
the WLAN module slot.

Reverse this procedure to install the WLAN module. 
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Memory module

Before removing the memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

Description Spare part number

For use only on computer models equipped with an AMD processor:

■ 2048-MB (800-MHz, DDR2) 538401-001

■ 1024-MB (800-MHz, DDR2) 538400-001

■ 512-MB (800-MHz, DDR2) 538399-001

■ 1024-MB (667-MHz, DDR2) 538397-001

■ 512-MB (667-MHz, DDR2) 538396-001

For use only on computer models equipped with an Intel processor:

■ 2048-MB (800-MHz, DDR2) 538436-001

■ 1024-MB (800-MHz, DDR2) 538435-001

■ 512-MB (800-MHz, DDR2) 538434-001

■ 2048-MB (667-MHz, DDR2) 538433-001

■ 1024-MB (667-MHz, DDR2) 538432-001

■ 512-MB (667-MHz, DDR2) 538431-001
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Remove the memory module:

✎ The top memory module slot is for expansion memory and the bottom slot is for primary memory.

1. Position the computer with the front toward you.

2. Loosen the Phillips PM2.0×6.0 captive screw 1 that secures the memory module compartment cover to 
the computer. 

3. Lift the front edge 2 of the memory module compartment cover to detach it from the computer.

4. Remove the memory module compartment cover 3. The memory module compartment cover is included in the 
Plastics Kit, spare part number 538450-001.

5. Spread the retaining tabs 1 on each side of the memory module to release the memory module. (The edge of 
the module opposite the slot rises away from the computer.) 

6. Remove the memory module 2 by pulling the module away from the slot at an angle. 

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory 
module slot.

Reverse this procedure to install a memory module.
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Optical drive

✎ The optical drive spare part kit includes an optical drive bezel and bracket.

Before removing the optical drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

Remove the optical drive:

1. Position the computer with the front toward you.

2. Remove the Phillips PM2.5×8.0 screw 1 that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access 2 and press the tab to the left to 
release the optical drive from the computer.

4. Remove the optical drive 3 from the optical drive bay.

Description Spare part number

For use only on computer models equipped with an AMD processor:

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 538406-001

■ DVD-ROM Drive 575200-001

For use only on computer models equipped with an Intel processor:

■ DVD±RW and CD-RW SuperMulti Double-Layer Drive with LightScribe 538442-001

■ DVD-ROM Drive 538441-001
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5. If it is necessary to replace the optical drive bracket, follow these steps:

a. Position the optical drive with the rear toward you. 

b. Remove the two Phillips PM2.0×3.0 screws 1 that secure the optical drive bracket to the optical drive. 

c. Remove the optical drive bracket 2. 

Reverse this procedure to reassemble and install the optical drive. 
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Removal and replacement procedures
Keyboard and switch cover

For use in country or region: Spare part number For use in country or region: Spare part number

■ For use in Belgium 539682-A41 ■ For use in Norway 539682-091

■ For use in Brazil 539682-201 ■ For use in Portugal 539682-131

■ For use in Bulgaria 539682-261 ■ For use in Russia 539682-251

■ For use in the Czech Republic 539682-221 ■ For use in Saudi Arabia 539682-171

■ For use in Denmark 539682-081 ■ For use in Slovakia 539682-231

■ For use in France 539682-051 ■ For use in Slovenia 539682-BA1

■ For use in French Canada 539682-121 ■ For use in South Korea 539682-AD1

■ For use in Germany 539682-041 ■ For use in Spain 539682-071

■ For use in Greece 539682-DJ1 ■ For use in Sweden and Finland 539682-B71

■ For use in Hungary 539682-211 ■ For use in Switzerland 539682-BG1

■ For use in Iceland 539682-DD1 ■ For use in Taiwan 539682-AB1

■ For use in Israel 539682-BB1 ■ For use in Thailand 539682-281

■ For use in Italy 539682-061 ■ For use in Turkey 539682-141

■ For use in Japan 539682-291 ■ For use in the United Kingdom 539682-031

■ For use in Latin America 539682-161 ■ For use in the United States 539682-001

■ For use in the Netherlands 539682-B31
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Removal and replacement procedures
Before removing the keyboard and switch cover, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

Remove the keyboard and switch cover:

1. Position the computer with the front toward you.

2. Remove the following screws:

1 Two Phillips PM2.5×8.0 screws that secure the keyboard to the computer

2 Two slotted Torx T8M2.5×8.0 screws that secure the switch cover to the computer

3 One Phillips PM2.0×2.0 broadhead screw that secures the switch cover to the computer

4 Two Phillips PM2.0×3.0 broadhead screws that secure the switch cover to the computer

Description Spare part number

Switch cover (includes power button board and cable) 538451-001
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Removal and replacement procedures
3. Turn the computer display-side up with the front toward you.

4. Open the computer as far as possible.

5. Lift the rear edge 1 of the switch cover until it rests at an angle.

6. Slide the switch cover 2 back until it rests on the display.

7. Lift the rear edge 1 of the keyboard until it rests at an angle.

8. Slide the keyboard 2 back until it rests on the switch cover and display.
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Removal and replacement procedures
9. Release the zero insertion force (ZIF) connector 1 to which the keyboard cable is attached, and disconnect the 
keyboard cable 2 from the system board.

10. Remove the keyboard.

11. Release the ZIF connector 1 to which the power button board cable is attached, and disconnect the power 
button board cable 2 from the system board.

12. Remove the switch cover 3.

Reverse this procedure to install the keyboard and switch cover.
Maintenance and Service Guide 4–23



Removal and replacement procedures
Speaker

Before removing the speaker, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6).

5. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-20).

Remove the speaker:

1. Disconnect the speaker cable 1 from the system board.

2. Release the speaker cable from the clips 2 built into the top cover.

3. Remove the two Phillips PM2.5×4.0 screws 3 that secure the speaker to the top cover.

4. Remove the speaker 4.

Reverse this procedure to install the speaker.

Description Spare part number

Speaker 538453-001
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Removal and replacement procedures
Display assembly

Before removing the display assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Disconnect the wireless antenna cables from the WLAN module (see “WLAN module” on page 4-12).

6. Remove the keyboard and switch cover (see “Keyboard and switch cover” on page 4-20).

7. Remove the speaker (see “Speaker” on page 4-24).

Description Spare part number

14.0-in, SVA, HD display assembly (includes 2 WLAN antenna transceivers and cables, webcam, microphone, nameplate, 
and logo):

For use only on computer models equipped with an AMD processor:

■ AntiGlare display assembly for use only on computer models equipped with a webcam 572524-001

■ AntiGlare display assembly for use only on computer models not equipped with a webcam 572523-001

■ BrightView display assembly for use only on computer models equipped with a webcam 572526-001

■ BrightView display assembly for use only on computer models not equipped with a webcam 572525-001

For use only on computer models equipped with an Intel processor:

■ AntiGlare display assembly for use only on computer models equipped with a webcam 538416-001

■ AntiGlare display assembly for use only on computer models not equipped with a webcam 538415-001

■ BrightView display assembly for use only on computer models equipped with a webcam 538419-001

■ BrightView display assembly for use only on computer models not equipped with a webcam 538418-001
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Removal and replacement procedures
Remove the display assembly:

1. Close the computer.

2. Turn the computer upside down with the front toward you.

3. Remove the WLAN antenna cables 1 from the clip 2 built into the base enclosure. 

4. Turn the computer display-side up with the front toward you.

5. Open the computer as far as possible.

6. Disconnect the display panel cable 1 from the system board.

7. Release the display panel cable from the clip 2 built into the top cover.
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Removal and replacement procedures
8. Disconnect the webcam module cable 1 from the system board.

9. Remove the wireless antenna cables 2 and the microphone cable from the clips 3 and routing channel built 
into the top cover.

Ä
CAUTION: Support the display assembly when removing the following screws. Failure to support the display assembly can 
result in damage to the display assembly and other computer components.

10. Remove the four Phillips PM2.5×6.0 screws 1 that secure the display assembly to the computer.

11. Lift the display assembly 2 straight up and remove it. 
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Removal and replacement procedures
12. If it is necessary to replace the display bezel or any of the display assembly internal components, remove the 
eight rubber screw covers 1 and 2 and the eight Phillips PM2.5×6.0 screws 3.

✎ The rubber screw covers 1 on the display bezel top edge and bottom inside edge are larger than the rubber screw 
covers 2 on the display bezel bottom outside corners. The display bezel rubber screw covers are included in the 
Rubber Kit, spare part number 538448-001.

13. Flex the inside edges of the top edge 1, the left and right sides 2, and the bottom edge 3 of the display bezel 
until the bezel disengages from the display enclosure.

14. Remove the display bezel 4. The display bezel is available using the following spare part numbers:

❏ 538426-001—for use only on computer models equipped with a webcam

❏ 538425-001—for use only on computer models not equipped with a webcam
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Removal and replacement procedures
15. If it is necessary to replace the webcam module, release the webcam module 1 as far from the display 
enclosure as the webcam module cable allows.

16. Disconnect the webcam module cable 2 from the webcam module.

17. Remove the webcam module. The webcam module is available using spare part number 538443-001.

18. If it is necessary to replace the display hinges, remove two Phillips PM2.5×5.0 screws 1 that secure the 
display panel to the display enclosure.

19. Remove the display panel 2 from the display enclosure.
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Removal and replacement procedures
20. Remove the eight Phillips PM2.0×3.0 screws 1 that secure the hinges to the display panel.

21. Remove the display hinges 2. The display hinges are available using spare part number 538461-001.

22. If it is necessary to replace the display panel cable, turn the display panel upside down with the bottom edge 
toward you.

23. Release the adhesive support strip 1 that secures the display panel cable to the display panel.

24. Disconnect the display panel cable 2 from the connector on the back of the display panel.

25. Remove the display panel cable 3. The display panel cable is included in the Display Cable Kit, spare part 
number 538463-001.
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Removal and replacement procedures
26. If it is necessary to replace the webcam module cable, release the tabs 1 built into the display enclosure 
shielding.

27. Remove the webcam module cable 2. The webcam module cable is included in the Display Cable Kit, spare 
part number 538463-001.

28. If it is necessary to replace the wireless antenna transceivers and cables, remove the Phillips PM2.5×4.0 
screws 1 that secure the transceivers to the display enclosure.

29. Release the transceivers 2 from the display enclosure. The transceivers are attached to the enclosure with 
double-sided tape.

30. Release the tabs 3 built into the display enclosure shielding.

31. Remove the wireless antenna transceivers and cables 4. The wireless antenna transceivers and cables are 
included in the Display Cable Kit, spare part number 538463-001.

Reverse this procedure to reassemble and install the display assembly.
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Removal and replacement procedures
Top cover

Before removing the top cover, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

Remove the top cover:

1. Turn the computer upside down with the front toward you.

2. Remove the six slotted Torx T8M2.5×8.0 screws 1 and the two Phillips PM2.0×2.0 broadhead screws 2 that 
secure the top cover to the base enclosure.

Description Spare part number

Top cover (includes TouchPad on/off board and cable, TouchPad button board and cable, and 
TouchPad board and cable)

538446-001
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Removal and replacement procedures
3. Turn the computer right-side up with the front toward you.

4. Remove the two Phillips PM2.5×6.0 screws 1 and the Phillips PM2.0×4.0 screw 2 that secure the top cover to 
the base enclosure.

5. Lift the rear edge 1 of the top cover until it rests at an angle.

6. Slide the top cover 2 back at an angle until the TouchPad cable 3 is accessible.

7. Disconnect the TouchPad cable from the system board.

8. Remove the top cover 4 by lifting it straight up.

Reverse this procedure to install the top cover. 
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Removal and replacement procedures
Bluetooth module

✎ The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module cables are 
included in the Cable Kit, spare part number 538465-001.)

Before removing the Bluetooth module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

Description Spare part number

Full-sized Bluetooth module 398393-002

Reduced form factor Bluetooth module 537921-001
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Removal and replacement procedures
Remove the Bluetooth module and cable: 

1. Disconnect the Bluetooth module cable 1 from the system board.

2. Remove the Bluetooth module cable from the clips 2 and routing channel built into the base enclosure.

3. Remove the Bluetooth module and cable 3.

Reverse this procedure to install the Bluetooth module. 
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Removal and replacement procedures
System board

✎ The system board spare part kit includes replacement thermal material.

Before removing the system board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

6. Disconnect the Bluetooth module cable from the system board (see “Bluetooth module” on page 4-34).

When replacing the system board, be sure that the following additional components are removed from the defective 
system board and installed on the replacement system board: 

■ WLAN module (see “WLAN module” on page 4-12)

■ Memory modules (see “Memory module” on page 4-16)

■ RTC battery (see “RTC battery” on page 4-40)

■ Modem module (see “Modem module” on page 4-42)

■ Heat sink (see “Heat sink” on page 4-44)

■ Modem module cable (see “Modem module cable” on page 4-48)

■ Processor (see “Processor” on page 4-49)

Description Spare part number

For use only on computer models equipped with an AMD processor:

■ For use only on computer models equipped with a graphics subsystem with discrete memory 538392-001

■ For use only on computer models equipped with a graphics subsystem with UMA memory 538391-001

For use only on computer models equipped with an Intel processor:

■ For use only on computer models equipped with a graphics subsystem with discrete memory 538408-001

■ GL system board for use only on computer models equipped with a graphics subsystem with 
UMA memory

538407-001

■ GM system board for use only on computer models equipped with a graphics subsystem with 
UMA memory

538409-001
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Removal and replacement procedures
Remove the system board:

1. Disconnect the fan cable 1 from the system board.

2. Remove the Phillips PM2.5×4.0 screw 2 that secures the system board to the base enclosure.

3. Release the RJ-11 connector 1 from the clip built into the base enclosure.

4. Flex the left side of the base enclosure 2 until the external monitor connector 3 is clear of the opening of the 
base enclosure.

5. Lift the rear edge of the system board 4 until it rests at an angle.

6. Remove the system board 5 by sliding it back.

Reverse this procedure to install the system board.
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Removal and replacement procedures
Fan

✎ To properly ventilate the computer, allow at least a 7.6-cm (3-in) clearance on the left side of the computer. The 
computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to 
turn on automatically when high temperature conditions exist. These conditions are affected by high external 
temperatures, system power consumption, power management/battery conservation configurations, battery fast 
charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side 
of the computer. 

Before removing the fan, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

g. System board (see “System board” on page 4-36)

Description Spare part number

Fan 538455-001
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Removal and replacement procedures
Remove the fan:

1. Remove the two Phillips PM2.5×6.0 screws 1 that secure the fan to the base enclosure.

2. Remove the fan 2.

Reverse this procedure to install the fan.
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Removal and replacement procedures
RTC battery

Before removing the RTC battery, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

g. System board (see “System board” on page 4-36)

Description Spare part number

RTC battery 449137-001
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Removal and replacement procedures
Remove the RTC battery:

1. Turn the system board upside down with the front toward you.

2. Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.
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Removal and replacement procedures
Modem module

✎ The modem module spare part kit does not include a modem module cable. The modem module cable is 
included in the Cable Kit, spare part number 538465-001. See “Modem module cable” on page 4-48 for modem 
module cable removal information.

Before removing the modem module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

g. System board (see “System board” on page 4-36)

Description Spare part number

For use in all countries and regions except Australia and New Zealand 510100-001

For use only in Australia and New Zealand 510100-011
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Removal and replacement procedures
Remove the modem module:

1. Turn the system board upside down with the front toward you.

2. Remove the two Phillips PM2.5×4.0 screws 1 that secure the modem module to the system board.

3. Disconnect the modem module 2 from the system board.

4. Disconnect the modem module cable 3 from the modem module.

5. Remove the modem module.

Reverse this procedure to install the modem module.
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Removal and replacement procedures
Heat sink

✎ The heat sink spare part kit includes replacement thermal material.

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

g. System board (see “System board” on page 4-36)

Description Spare part number

For use only on computer models equipped with an AMD processor:

■ For use only on computer models equipped with a graphics subsystem with discrete memory 538459-001

■ For use only on computer models equipped with a graphics subsystem with UMA memory 538456-001

For use only on computer models equipped with an Intel processor:

■ For use only on computer models equipped with a graphics subsystem with discrete memory 538458-001

■ For use only on computer models equipped with a graphics subsystem with UMA memory 538457-001
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Removal and replacement procedures
Remove the heat sink:

1. Turn the system board upside down with the front toward you.

✎ Steps 2 and 3 apply to computer models equipped with graphics subsystems with discrete memory. See steps 4 
and 5 for instructions on removing the heat sink on computer models equipped with graphics subsystems with 
UMA memory.

2. Loosen the four Phillips PM2.5×9.0 captive screws 1 and the two Phillips PM2.0×5.0 captive screws 2 that 
secure the heat sink to the system board.

3. Remove the heat sink 3.

✎ Due to the adhesive quality of the thermal material located between the heat sink and system board components, 
it may be necessary to move the heat sink from side to side to detach the heat sink.
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Removal and replacement procedures
✎ The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board each time 
the heat sink is removed:
■ Thermal paste is used on the processor 1 and the heat sink section 2 that services it.
■ Thermal pads are used on the Northbridge chip 3 and the heat sink section 4 that services it.
■ Thermal pads are used on the graphics subsystem memory module 5 and the heat sink section 6 that 

services it.

Replacement thermal material is included with all system board, heat sink, and processor spare part kits.

✎ Steps 4 and 5 apply to computer models equipped with graphics subsystems with UMA memory. See steps 2 
and 3 for instructions on removing the heat sink on computer models equipped with graphics subsystems with 
discrete memory.

4. Loosen the four Phillips PM2.5×9.0 captive screws 1 and the two Phillips PM2.0×5.0 captive screws 2 that 
secure the heat sink to the system board.

5. Remove the heat sink 3.

✎ Due to the adhesive quality of the thermal material located between the heat sink and system board components, 
it may be necessary to move the heat sink from side to side to detach the heat sink.
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Removal and replacement procedures
✎ The thermal material must be thoroughly cleaned from the surfaces of the heat sink and the system board each time 
the heat sink is removed:
■ Thermal paste is used on the processor 1 and the heat sink section 2 that services it.
■ Thermal pads are used on the Northbridge chip 3 and the heat sink section 4 that services it.

Replacement thermal material is included with all system board, heat sink, and processor spare part kits.

Reverse this procedure to install the heat sink.
Maintenance and Service Guide 4–47



Removal and replacement procedures
Modem module cable

✎ The modem module cable is included in the Cable Kit, spare part number 538465-001.

Before removing the modem module cable, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

g. System board (see “System board” on page 4-36)

h. Heat sink (see “Heat sink” on page 4-44)

Remove the modem module cable: 

1. Disconnect the modem module cable 1 from the modem module.

2. Remove the modem module cable 2.

Reverse this procedure to install the modem module cable. 
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Removal and replacement procedures
Processor

✎ The processor spare part kit includes replacement thermal material.

Before removing the processor, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-6). 

5. Remove the following components: 

a. Hard drive (see “Hard drive” on page 4-8)

b. Optical drive (see “Optical drive” on page 4-18)

c. Keyboard and switch cover (see “Keyboard and switch cover” on page 4-20)

d. Speaker (see “Speaker” on page 4-24)

e. Display assembly (see “Display assembly” on page 4-25)

f. Top cover (see “Top cover” on page 4-32)

g. System board (see “System board” on page 4-36)

h. Heat sink (see “Heat sink” on page 4-44)

Description Spare part number

AMD Turion RM-74 2.20-GHz processor (1-MB L2 cache) 507979-001

AMD Turion RM-72 2.10-GHz processor (1-MB L2 cache) 507978-001

AMD Athlon QL-64 2.10-GHz processor (1-MB L2 cache) 506053-001

AMD Athlon QL-62 2.00-GHz processor (1-MB L2 cache) 506052-001

AMD Sempron SI-42 2.10-GHz processor (512-KB L2 cache) 508102-001

Intel Core2 Duo processors:

■ T5870 2.00-GHz processor (2-MB L2 cache, 800-MHz FSB) 535835-001

■ T1500 1.86-GHz processor (1-MB L2 cache, 800-MHz FSB) 576209-001

Intel Celeron processors:

■ 560 2.13-GHz processor (1-MB L2 cache, 533-MHz FSB) 576208-001

■ 550 2.00-GHz processor (1-MB L2 cache, 533-MHz FSB) 576207-001
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Removal and replacement procedures
Remove the processor:

1. Use a flat-bladed screwdriver to turn the processor locking screw 1 one-half turn counterclockwise until you 
hear a click. 

2. Lift the processor 2 straight up and remove it. 

✎When you install the processor, the gold triangle 3 on the processor must be aligned with the triangle 4 
embossed on the processor socket. 

 

Reverse this procedure to install the processor.
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5
Computer Setup

Computer Setup for computer models equipped with an AMD processor

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer. 
An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the tab key and the keyboard arrow keys and then press enter, or use a 
pointing device to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen, or use 
the up arrow key or the down arrow key.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎ You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate and 
make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.
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Computer Setup
To exit Computer Setup menus, choose one of the following methods:
■ To exit without saving your changes: Click the Exit icon in the lower-left corner of the screen, and then follow 

the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press enter.

■ To save your changes and exit Computer Setup menus: Click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 

displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit:

Click the Save icon in the lower-left corner of the screen, and then follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.
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Computer Setup
Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File Menu

Select To do this

System Information ■ View identification information for the computer and the batteries in 
the system.

■ View specification information for the processor, cache and memory 
size, system ROM, video revision, and keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the original 
factory settings. (Hard drive mode, password settings, and security 
settings are not changed when you restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and 
restart the computer.

Save changes and exit Save any changes entered during the current session. Then exit and 
restart the computer. Your changes go into effect when the computer 
restarts.
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Computer Setup
Security Menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Diagnostics Menu

Select To do this

Setup BIOS Administrator Password Set up a BIOS administrator password.

User Management (requires a BIOS administrator 
password)

■ Create a new BIOS user account.

■ View a list of ProtectTools users.

Password Policy (requires a BIOS administrator 
password)

Revise password policy criteria.

HP SpareKey Enable/disable HP SpareKey (disabled by default).

Always Prompt for HP SpareKey Enrollment Enable/disable HP SpareKey enrollment (disabled by default).

Allow Reset of HP ProtectTools security keys Enable/disable reset of HP ProtectTools security keys.

Change Password Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security questions and 
answers used if you forget your password.

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive (enabled by 
default).

■ Change a DriveLock user password or master password.

✎ DriveLock settings are accessible only when you enter Computer 
Setup by turning on (not restarting) the computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive 
or the drive in the upgrade bay.

Ä If you run Disk Sanitizer, the data on the selected drive is 
destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and 
ownership tag.

Select To do this

System Diagnostics Menu ■ System Information—Displays the following information:

❐ Identification information for the computer and the batteries in the 
system.

❐ Specification information for the processor, cache and memory 
size, system ROM, video revision, and keyboard controller 
version.

■ Start-up Test—Verifies the system components needed for starting 
the computer.

■ Run-In Test—Runs a comprehensive check on system memory.

■ Hard Disk Test—Runs a comprehensive self-test on any hard drive in 
the system.

■ Error Log—Displays a log file if any errors have occurred.
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Computer Setup
System Configuration Menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language  Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds).

■ Enable/disable Custom Logo (disabled by default).

■ Enable/disable Display Diagnostic URL (enabled by default).

■ Enable/disable CD-ROM boot (enabled by default).

■ Enable/disable SD Card boot (enabled by default).

■ Enable/disable floppy boot (enabled by default).

■ Enable/disable PXE Internal NIC boot (disabled by default).

■ Set the Express Boot Popup delay in seconds.

■ Set the boot order.

Device Configurations ■ Enable/disable USB legacy support (enabled by default). When 
enabled, USB legacy support allows the following:

❐ Use of a USB keyboard in Computer Setup even when a Windows 
operating system is not running.

❐ Startup from bootable USB devices, including a hard drive, 
diskette drive, or optical drive connected by a USB port to the 
computer.

■ Enable/disable fan always on while connected to an AC outlet 
(disabled by default).

■ SATA (Serial Advanced Technology Attachment) device mode. The 
following options are available:

❐ AHCI (Advanced Host Controller Interface)
❐ IDE (Integrated Drive Electronics)

✎ Availability of the options above varies by computer model.

■ Enable/Disable Unified Extensible Firmware Interface (UEFI) mode 
(disabled by default).

(Continued)
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Computer Setup
System Configuration menu (continued)

Built-In Device Options ■ Enable/disable the wireless button state (enabled by default).

■ Enable/disable embedded Bluetooth device radio (enabled by 
default).

■ Enable/disable the Network Interface Controller (LAN) (enabled by 
default).

■ Set the wake on LAN state. Options include the following:

❐ Disabled

❐ Boot to Network (set by default)
❐ Follow Boot Order

■ Enable/disable the optical disc drive (enabled by default).

■ Enable/disable the microphone.

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the embedded WLAN device (enabled by default).

■ Enable/disable LAN/WLAN switching (disabled by default).

■ Enable/disable the integrated camera (select models only; enabled 
by default).

Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the ExpressCard slot.

■ Enable/disable the flash media reader.

■ Enable/disable the USB port.

Ä Disabling the USB port also disables MultiBay devices and 
ExpressCard devices on the advanced port replicator.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this
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Computer Setup
Computer Setup for computer models equipped with an Intel processor

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate and make selections.

An external keyboard connected by USB can be used with Computer Setup only if USB legacy support is enabled.

To start Computer Setup, follow these steps:
1. Turn on or restart the computer.

2. Before Windows opens and while the “F10=ROM Based Setup” message is displayed in the lower-left corner 
of the screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and System 
Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the “F10 = ROM 
Based Setup” message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation and selection are 
by keystroke:

❏ To choose a menu or a menu item, use the arrow keys.
❏ To select an item, press enter.
❏ To close open dialog boxes and return to the main Computer Setup screen, press esc.
❏ To view navigation information, press f1.
❏ To change the language, press f2.

2. Select the File, Security, Diagnostics or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

❏ To exit Computer Setup without saving your preferences, use the arrow keys to select File > Ignore 
changes and exit. Then follow the instructions on the screen.

❏ To save your preferences and exit Computer Setup, use the arrow keys to select File > Save changes and 
exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
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Computer Setup
Restoring factory settings in Computer Setup

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the “F10 = ROM 

Based Setup” message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save changes and exit. 
Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer.

File Menu

Select To do this

System information ■ View identification information for the computer and the batteries in 
the system.

■ View specification information for the processor, cache and memory 
size, system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original 
factory settings. (Password settings and security settings are not 
changed when you restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and 
restart the computer.

Save changes and exit Save any changes entered during the current session. Then exit and 
restart the computer. Your changes go into effect when the computer 
restarts.
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Computer Setup
Security Menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Diagnostics Menu

Select To do this

Setup Password Enter, change, or delete a setup password.

Power-On Password Enter, change, or delete a power-on password.

Password Options ■ Enable/disable stringent security.

■ Enable/disable the password requirement on computer restart.

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive.

■ Change a DriveLock user password or master password.

✎ DriveLock settings are accessible only when you 
enter Computer Setup by turning on (not restarting) 
the computer.

System IDs Enter a user-defined computer asset tracking number and ownership 
tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard 
drive. The following options are available:

■ Fast: Runs the Disk Sanitizer erase cycle once.

■ Optimum: Runs the Disk Sanitizer erase cycle 3 times.

■ Custom: Allows you to select the desired number of Disk Sanitizer 
erase cycles from a list.

■ Last status: Provides information about the last time Disk Sanitizer 
ran on the computer.

Ä If you run Disk Sanitizer, the data on the primary hard drive is 
destroyed permanently.

Select To do this

HDD Self-Test Options Run a comprehensive self-test on any hard drive in the system.

Memory Check Run a comprehensive test on system memory.

Startup check Verify the system components needed for starting the computer.
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Computer Setup
System Configuration Menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot Options ■ Set an f9, f10, and f12 delay when starting up.

■ Enable/disable CD-ROM boot.

■ Enable/disable floppy boot.

■ Enable/disable internal network adapter boot and set the boot 
mode (PXE).

■ Enable/disable MultiBoot, which sets a boot order that can include 
most boot devices in the system.

■ Set the Express Boot Popup delay in seconds.

■ Set the boot order.

Device Configurations ■ Swap the functions of the fn key and left ctrl key.

■ Enable/disable USB legacy support. When enabled, USB legacy 
support allows the following:

❐ Use of a USB keyboard in Computer Setup even when 
a Windows operating system is not running.

❐ Startup from bootable USB devices, including a hard drive, 
diskette drive, or optical drive connected by a USB port to the 
computer.

■ Enable/disable BIOS DMA data transfers.

■ Enable/disable fan always on while connected to an AC outlet.

■ Enable/disable Data Execution Prevention. When enabled, the 
processor can disable some virus code execution, which helps to 
improve computer security.

■ Enable/disable SATA Native Mode.

■ Enable/disable Dual Core CPU.

■ Choose Bit-shift or LBA-assisted HDD Translation Mode.

■ Enable/disable Virtualization Technology.

Built-In Device Options ■ Enable/disable embedded WLAN Device Radio.

■ Enable/disable Wake on LAN.

■ Enable/disable the optical disc drive.

Port Options ■ Enable/disable the USB port.

■ Enable/disable the ExpressCard slot.
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6
Specifications

Computer specifications

Metric U.S.

Dimensions

Length 23.39 cm 9.21 in

Width 33.60 cm 13.23 in

Height 3.20 cm 1.26 in

Weight <2.27 kg <5.0 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A - 65 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

✎ Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this 
range of temperatures.
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Specifications
14.0-in display specifications

Metric U.S. 

Dimensions

Height 20.83 cm 8.2 in

Width 27.94 cm 11.0 in

Diagonal 35.81 cm 14.0 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle ±40° horizontal, +120°/-40° vertical (typical)
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Specifications
Hard drive specifications

500-GB* 320-GB* 250-GB* 160-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.0 ms 1.5 ms 2.0 ms 2.0 ms

Average 14.0 ms 12.0 ms 12.0 ms 12.0 ms

Maximum 22.0 ms 22.0 ms 22.0 ms 22.0 ms

Logical blocks 976,773,168 625,142,448 488,397,168 312,581,808

Disc rotational speed 5400 rpm 5400rpm 7200 and 
5400 rpm

7200 and 
5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive 
specifications may differ slightly.

✎ Certain restrictions and exclusions apply. Contact technical support for details.
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Specifications
DVD±RW and CD-RW SuperMulti Double-Layer Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CD-ROM, 
CD-ROM XA, 
MIXED MODE CD, CD-I, 
CD-I Bridge (Photo-CD, 
Video CD), Multisession CD 
(Photo-CD, CD-EXTRA, 
Portfolio, CD-R, CD-RW), 
CD-R, CD-RW, DVD-ROM 
(DVD-5, DVD-9, DVD-10, 
DVD-18), DVD-R, DVD-RW, 
DVD+R, DVD+RW, DVD-RAM

CD-R, CD-RW, DVD+R, 
DVD+RW, DVD-R, DVD-RW, 
DVD-RAM

Access time CD DVD

Random < 175 ms < 230 ms

Cache buffer 2.5 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

16X CD-RW 2,400 KB/sec

8x DVD+R 10,800 KB/sec

4X DVD+RW 5,400 KB/sec

8X DVD-R 10,800 KB/sec

4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9) 2,700 KB/sec

5X DVD-RAM 6,750 KB/sec

Transfer mode Multiword DMA mode
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Specifications
DVD-ROM Drive specifications

Applicable disc Read: Write:

CD-DA, CD+(E)G, CD-MIDI, 
CD-TEXT, CD-ROM, 
CD-ROM XA, MIXED 
MODE CD, CD-I, CD-I Bridge 
(Photo-CD, Video CD), 
Multisession CD (Photo-CD, 
CDEXTRA, Portfolio, CD-R, 
CD-RW), CDR, CD-RW, 
DVD-ROM (DVD-5, DVD-9, 
DVD-10, DVD-18), DVD-R, 
DVD-RW, DVD+R, DVD+RW, 
DVD-RAM

CD-R and CD-RW

Access time CD DVD

Random < 110 ms < 130 ms

Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec

8X DVD 10,800 KB/sec

24X CD-R 3,600 KB/sec

24X CD-RW 3,600 KB/sec
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Specifications
System DMA specifications

Hardware DMA System function 

DMA0 Not applicable 

DMA1* Not applicable 

DMA2* Not applicable 

DMA3 Not applicable 

DMA4 Direct memory access controller 

DMA5* Not applicable 

DMA6 Not assigned 

DMA7 Not assigned 

*ExpressCard controller can use DMA 1, 2, or 5. 
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Specifications
System memory map specifications

Size Memory address System function 

640 KB 00000000-0009FFFF Base memory 

128 KB 000A0000-000BFFFF Video memory 

64 KB 000C0000-000CFFFF Video BIOS 

64 KB 000E8000-000FFFFF System BIOS 

00100000- XFFFFFFF Extended memory (based on 
memory installed)

(X+1)0000000-FEDFFFFF PCI bus

FED00000-FED003FF High precision event timer

FEE01000-FFFFFFFF PCI bus 
Maintenance and Service Guide 6–7



Specifications
System interrupt specifications

Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-key or Microsoft natural keyboard

IRQ8 System CMOS/real-time clock

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ16 Intel ICH9 family USB universal host controller 2937
Mobile Intel 4 Series express chipset family

IRQ17* High definition audio controller
Intel ICH9 family USB universal host controller 2938 
Marvell Yukon 88E8072 PCIE-gigabit Ethernet controller

IRQ18 Intel ICH9 family USB universal host controller 2939
Intel ICH9 family USB universal host controller 2936

IRQ19 Intel ICH9 family USB2 enhanced controller 293C

IRQ20 Intel ICH9 family USB2 enhanced controller 293A
Intel ICH9 family USB universal host controller 2934

IRQ21 Intel ICH9M-E/M SATA AHCI controller

IRQ22 Intel ICH9 family USB universal host controller 2935

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none. 

✎ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port 
may assert IRQ3 or IRQ4. 

✎ For operating systems after Windows 2000, APIC (Advanced programming interrupt controller) is used.
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Specifications
System I/O address specifications

I/O address (hex) System function (shipping configuration) 

000 - 01F DMA controller

020 - 021 Program interrupt controller

024 - 025 Program interrupt controller

028 - 029 Program interrupt controller

02C - 03D Program interrupt controller

02E - 02F Motherboard resources

030 - 031 Program interrupt controller

034 - 035 Program interrupt controller

038 - 039 Program interrupt controller

03C- 03D Program interrupt controller

040 - 043 System timer

04E-04F Motherboard resources

050-053 System timer

060 Standard 101-/102-key or Microsoft natural keyboard

061 Motherboard resources

062 Microsoft ACPI-compliant embedded controller

063 Motherboard resources

064 Standard 101-/102-key or Microsoft natural keyboard

065 Motherboard resources

066 Microsoft ACPI-compliant embedded controller

067 Motherboard resources

070 Motherboard resources

071-077 System CMOS/real time clock

080 Motherboard resources

081-091 Direct memory access controller

092 Motherboard resources

093-09F Direct memory access controller

0A0-0A1 Program interrupt controller

0A4-0A5 Program interrupt controller

0A8-0A9 Program interrupt controller

0AC-0AD Program interrupt controller

0B0-0B1 Program interrupt controller

0B2-0B3 Motherboard resources

0B4- 0B5 Program interrupt controller

0B8-0B9 Program interrupt controller

0BC- 0BD Program interrupt controller

(Continued)
Maintenance and Service Guide 6–9



Specifications
0C0- 0DF Direct memory access controller

0F0- 0F0 Numeric data processor

0200-027F Motherboard resources

3B0-3BB Mobile Intel 4 series express chipset family

3C0-3DF Mobile Intel 4 series express chipset family

400-47F Motherboard resources

4D0-4D1 Programmable interrupt controller

500-57F Motherboard resources

1000-1003 Motherboard resources

1010-101F Motherboard resources

2000-20FF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet controller

2000-2FFF ICH9 family PCI express root port6-294A

3000-4FFF ICH9 family PCI express root port5-2948

5000-6FFF ICH9 family PCI express root port3-2944

7000-701F ICH9M-E/M SATA AHCI controller

7020-703F ICH9 family USB universal host controller-2936

7040-705F ICH9 family USB universal host controller-2935

7060-707F ICH9 family USB universal host controller-2934

7080-709F ICH9 family USB universal host controller-2939

70A0-70BF ICH9 family USB universal host controller-2938

70C0-70DF ICH9 family USB universal host controller-2937

70E0-70E7 ICH9M-E/M SATA AHCI controller

70E8-70EF ICH9M-E/M SATA AHCI Controller

70F0-70F7 Mobile Intel 4 series express chipset family

70F8-70FB ICH9M-E/M SATA AHCI controller

70FC-70FF ICH9M-E/M SATA AHCI controller

EF80-EF9F Motherboard resources

FE00-FE0F Motherboard resources

FE80-EF8F Motherboard resources

FFFF Motherboard resources

I/O address (hex) System function (shipping configuration) 
6–10 Maintenance and Service Guide



7
Screw listing

This section provides specification and reference information for the screws used in the computer. The screws 
listed in this section are available in the Screw Kit, spare part number 538449-001. 

Phillips PM2.0×6.0 captive screw

Where used:

1 Two captive screws that secure the hard drive cover to the computer (screws are secured on the hard drive cover 
by C-clips)

2 One captive screw that secures the memory module compartment cover to the computer (screw is secured on the 
memory module compartment cover by a C-clip)

Color Quantity Length Thread Head diameter 

Black 3 6.0 mm 2.0 mm 5.0 mm
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Screw listing
Phillips PM2.5×11.0 captive screw

 

Where used: One screw that secures the hard drive to the computer (screw is secured to the hard drive bracket)

Color Quantity Length Thread Head diameter 

Black 1 11.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM3.0×4.0 screw

 

Where used: 4 screws that secure the hard drive bracket to the hard drive

Color Quantity Length Thread Head diameter 

Silver 4 4.0 mm 3.0 mm 5.0 mm
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Screw listing
Black Phillips PM2.5×4.0 screw

Where used: 2 screws that secure the WLAN module to the computer

Where used: 2 screws that secure the speaker to the top cover

Color Quantity Length Thread Head diameter 

Black 9 4.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: 2 screws that secure the wireless antenna transceivers to the display enclosure

Where used: One screw that secures the system board to the base enclosure

Where used: 2 screws that secure the modem module to the system board
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Screw listing
Silver Phillips PM2.5×4.0 screw

Where used: 2 screws that secure the wireless antenna transceivers to the display enclosure

Color Quantity Length Thread Head diameter 

Silver 2 4.0 mm 2.5 mm 5.0 mm
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Screw listing
Slotted Torx T8M2.5×8.0 screw

 

Where used:

1 Two screws that secure the switch cover to the computer

2 Six screws that secure the top cover to the computer

Color Quantity Length Thread Head diameter 

Black 8 8.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM2.0×3.0 screw

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 2 screws that secure the Bluetooth module to the base enclosure

Color Quantity Length Thread Head diameter 

Black 4 3.0 mm 2.0 mm 4.5 mm
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Screw listing
Phillips PM2.0×3.0 screw

Where used: 8 screws that secure the display hinges to the display panel

Color Quantity Length Thread Head diameter 

Silver 8 3.0 mm 2.0 mm 4.5 mm
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Screw listing
Phillips PM2.0×2.0 broadhead screw

 

Where used: 2 screws that secure the switch cover to the computer in the battery bay

Color Quantity Length Thread Head diameter 

Black 2 2.0 mm 2.0 mm 7.0 mm
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Screw listing
Phillips PM2.0×3.0 broadhead screw

 

Where used:

1 One screw that secures the switch cover to the computer in the optical drive bay

2 Two screws that secure the top cover to the computer

Color Quantity Length Thread Head diameter 

Black 3 3.0 mm 2.0 mm 7.0 mm
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Screw listing
Phillips PM2.5×8.0 screw

 

Where used:

1 One screw that secures the optical drive to the computer

1 Two screws that secure the keyboard to the computer

Color Quantity Length Thread Head diameter 

Black 3 8.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM2.0×4.0 screw

 

Where used: One screw that secures the top cover to the base enclosure

Color Quantity Length Thread Head diameter 

Black 1 4.0 mm 2.0 mm 4.5 mm
Maintenance and Service Guide 7–13



Screw listing
Phillips PM2.5×6.0 screw

 

Where used: 4 screws that secure the display assembly to the computer

Where used: 8 screws that secure the display bezel to the display assembly

Color Quantity Length Thread Head diameter 

Black 16 6.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: 2 screws that secure the top cover to the base enclosure

Where used: 2 screws that secure the fan to the base enclosure
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Screw listing
Phillips PM2.5×5.0 screw

 

Where used: 2 screws that secure the display panel to the display enclosure

Color Quantity Length Thread Head diameter 

Black 2 5.0 mm 2.5 mm 5.0 mm
7–16 Maintenance and Service Guide



Screw listing
Phillips PM2.5×9.0 captive screw

 

Where used: 4 captive screws that secure the heat sink to the system board on computer models with a graphics 
subsystem with discrete memory (screws are secured on the heat sink by C-clips)

Color Quantity Length Thread Head diameter 

Silver 4 9.0 mm 2.5 mm 5.0 mm
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Screw listing
Where used: 4 captive screws that secure the heat sink to the system board on computer models with a graphics 
subsystem with UMA memory (screws are secured on the heat sink by C-clips)
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Screw listing
Phillips PM2.0×5.0 captive screw

 

Where used: 2 captive screws that secure the heat sink to the system board on computer models with a graphics 
subsystem with discrete memory (screws are secured on the heat sink by C-clips)

Color Quantity Length Thread Head diameter 

Silver 2 5.0 mm 2.0 mm 5.0 mm
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Screw listing
Where used: 2 captive screws that secure the heat sink to the system board on computer models with a graphics 
subsystem with UMA memory (screws are secured on the heat sink by C-clips)
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Backup and recovery

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders, back up 
your entire hard drive (select models only), or create system restore points. In case of system failure, you can use 
the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

■ Backing up individual files and folders

■ Backing up the entire hard drive (select models only)

■ Scheduling automatic backups (select models only)

■ Creating system restore points

■ Recovering individual files

■ Restoring the computer to a previous state

■ Recovering information using recovery tools

✎ For detailed instructions, perform a search for these topics in Help and Support. 
In case of system instability, HP recommends that you print the recovery procedures and save them for later use.
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Backup and recovery
Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

■ Store personal files in the Documents folder, and back it up regularly.

■ Back up templates that are stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.The screen image is added to the 
document.

4. Save the document.

■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD-RW. The discs you use will depend on the type of optical 
drive installed in your computer.

✎ DVDs and DVDs with double-layer (DL) support store more information than CDs, so using them for backup 
reduces the number of recovery discs required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer. To create 
a backup using Backup and Restore Center, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.
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Backup and recovery
Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools: You can use the Backup and Restore Center to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows 
from starting correctly.

■ f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image 
includes the Windows operating system and software programs installed at the factory.

✎ If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. For additional information, refer to the “Using a Windows 
Vista operating system DVD (purchased separately)” section in this chapter.

Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

✎ Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

Ä
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive. All files you have created 
and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process 
restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find the 
partitions, select Start > Computer.

✎ If the Windows partition and the HP Recovery partition have been deleted, you must recover your operating 
system and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both 
purchased separately). For additional information, refer to the “Using a Windows Vista operating system DVD 
(purchased separately)” section in this chapter.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

✎ For additional information on recovering information using the Windows tools, perform a search for these topics 
in Help and Support.
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Backup and recovery
Using f11

Ä
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you have created and any 
software installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and 
HP programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select Start > 
Computer.

✎ If the HP Recovery partition has been deleted, you must recover your operating system and programs using the 
Windows Vista operating system DVD and the Driver Recovery disc (both purchased separately). For additional 
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section in 
this chapter.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message 
is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. Make sure that your most recent backup (stored on discs or on 
an external drive) is easily accessible. To order a Windows Vista operating system DVD, go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions. You can also order the 
DVD by calling technical support. For contact information, refer to the Worldwide Telephone Numbers booklet 
included with the computer.

Ä
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and reformats the hard drive. 
All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, 
the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

✎ This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery
Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and folders or 
create recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

■ Backing up individual files and folders

■ Backing up all files and folders

■ Scheduling automatic backups

■ Creating recovery points

■ Recovering information

✎ For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

■ Store personal files in the My Documents folder, and back it up periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

The backup process may take over an hour, depending on file size and the speed of the computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.
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Backup and recovery
Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools (select models only): You can use the Windows Backup utility to recover information 
you have previously backed up.

■ Operating System and Driver Recovery discs (included with your computer): You can use the discs to recover 
your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

✎ For additional information on initiating a recovery in Windows, perform a search for this topic in 
Help and Support.

Recovering the operating system and programs

Ä
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have created and any software 
installed on the computer are permanently removed. The recovery process reinstalls the original operating system, software, and 
drivers. Software, drivers, and updates not installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the 
Driver Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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9
Connector pin assignments

Audio-in (microphone)

 

Audio-out (headphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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Connector pin assignments
External monitor

 
Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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Connector pin assignments
RJ-11 (modem)

RJ-45 (network)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

7 Unused

8 Unused

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Connector pin assignments
Universal Serial Bus

 

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground
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10
Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts AC 
or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region 
where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where 
the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

■ The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the 
country or region where the power cord set will be used.

■ The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 125 or 
250 V AC, as required by the power system of each country or region.

■ The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of the computer.
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Power cord set requirements
Requirements for specific countries and regions

Country/region Accredited agency Applicable note number 

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a 
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household waste. 
Follow the local laws and regulations in your area for computer battery disposal.

Display

Å
WARNING: The backlight contains mercury. Caution must be exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this chapter can result in damage to display components. The only components intended for 
recycling purposes are the liquid crystal display (LCD) panel and the backlight. When you remove these components, handle 
them carefully.

✎ Materials Disposal. This HP product contains mercury in the backlight in the display assembly that might 
require special handling at end-of-life. Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact your local authorities, or see the Electronic 
Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be 
disassembled to gain access to the backlight 1 and the liquid crystal display (LCD) panel 2.

✎ The procedures provided in this chapter are general disassembly instructions. Specific details, such as screw 
sizes, quantities, and locations, and component shapes and sizes, can vary from one computer model to another.
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Recycling
Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges 1 and the top and bottom inside edges 2 of the display bezel 
until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
11–2 Maintenance and Service Guide



Recycling
4. Disconnect all display panel cables 1 from the display inverter and remove the inverter 2.

5. Remove all screws 1 that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly 2 from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.
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Recycling
9. Use a sharp-edged tool to cut the tape 1 that secures the sides of the display panel to the display panel frame.

10. Remove the display panel frame 2 from the display panel.
 

11. Remove the screws 1 that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover 2 and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the display panel.
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Recycling
16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

Å
WARNING: The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging this 
component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
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Recycling
19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the display rear panel.

21. Release the LCD panel 3 from the display rear panel.

22. Release the tape 4 that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter, spare part numbers 3–12, 3–13
antenna

disconnecting 4–15
locations 2–1
removal 4–31
spare part number 4–31

audio product description 1–5
audio-in jack

connector pinout 9–1
location 2–2, 2–7

audio-out jack
connector pinout 9–1
location 2–2, 2–7

B
backing up files 8–2
Backup and Restore Center 8–1, 8–2
base enclosure, spare part number 3–6, 3–16
battery

removal 4–6
spare part numbers 3–6, 3–18, 4–6

battery bay 2–10
battery light 2–9
battery release latch 2–10
BIOS administrator password 5–4
Bluetooth module

removal 4–34
spare part numbers 3–5, 3–13, 3–15, 4–34

boot options 5–5, 5–10
boot order 5–5, 5–10
bottom components 2–10
built-in device

Bluetooth device radio 5–6
embedded WLAN 5–6
integrated camera 5–6
LAN/WLAN switching 5–6
microphone 5–6
modem 5–6
Network Interface Controller (LAN) 5–6
optical disc drive 5–6
wake on LAN 5–6
wireless button 5–6

built-in device options 5–6
buttons

power 2–3
TouchPad 2–6
wireless 2–3

C
Cable Kit, spare part number 3–5, 3–17
cables, service considerations 4–1
caps lock light 2–5
chipset product description 1–2
components

bottom 2–10
buttons 2–3
display 2–1
fingerprint reader 2–3
front 2–7
keys 2–4
left-side 2–9
lights 2–5
pointing device 2–6
right-side 2–8
top 2–1

computer feet
locations 4–6
spare part number 4–6

Computer Setup
accessing 5–1, 5–7
Diagnostics menu 5–4, 5–9
File menu 5–3, 5–8
navigating and selecting 5–1, 5–7
restoring factory settings 5–2, 5–8
Security menu 5–4, 5–9
System Configuration menu 5–5, 5–10
using 5–1, 5–7

computer specifications 6–1
connector pinout

audio-in jack 9–1
audio-out jack 9–1
external monitor port 9–2
headphone jack 9–1
microphone jack 9–1
modem jack 9–3
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Index
monitor port 9–2
network jack 9–3
RJ-11 jack 9–3
RJ-45 jack 9–3
USB port 9–4

connectors, service considerations 4–1
creating a backup 8–2

D
device configurations 5–5
Diagnostics menu 5–4
Disk Sanitizer 5–4, 5–9
display assembly

removal 4–25
spare part numbers 3–3, 3–16, 3–18, 4–25

display bezel
illustrated 3–10
removal 4–28
spare part numbers 3–10, 3–16, 4–28

Display Cable Kit
illustrated 3–10
spare part number 3–10, 3–17

display components
illustrated 2–1
recycling 11–1
spare part numbers 3–10

display enclosure
illustrated 3–10
removal 4–28
spare part number 3–10, 3–16

display hinge
illustrated 3–10
removal 4–29
spare part number 3–10, 3–17, 4–30

display inverter, removal 11–3
display panel cable

illustrated 3–10
removal 4–30
spare part number 4–30

display panel, product description 1–2
display switch 2–3
DriveLock password 5–4, 5–9
DriveLock, automatic 5–4
drives, boot order 5–5, 5–10
DVD±RW and CD-RW SuperMulti Double-Layer 

Drive
precautions 4–2
removal 4–18
spare part numbers 3–8, 3–11, 3–15, 3–16, 4–18
specifications 6–4

DVD-ROM Drive
precautions 4–2
removal 4–18
spare part numbers 3–8, 3–11, 3–16, 3–18, 4–18
specifications 6–5

E
electrostatic discharge 4–2
equipment guidelines 4–4
error log 5–4
esc key 2–4
Ethernet product description 1–5
Execution Disable 5–10
ExpressCard slot 2–9
ExpressCard slot bezel, illustrated 3–9
external media card product description 1–6
external monitor port

connector pinout 9–2
location 2–9

F
f11 recovery 8–4
fan

removal 4–38
spare part number 3–6, 3–17, 4–38

feet
locations 4–6
spare part number 4–6

File menu 5–3, 5–8
fn key 2–4
front components 2–7
function keys 2–4

G
graphics product description 1–2
grounding equipment and methods 4–2

H
hard disk test 5–4
hard drive

precautions 4–2
product description 1–4
removal 4–8
spare part numbers 3–8, 3–11, 3–15, 3–16, 3–18, 

4–8
specifications 6–3

hard drive bay 2–10
hard drive bracket, removal 4–11
hard drive cover

illustrated 3–9
removal 4–9

hard drive recovery 8–4
hard drive test 5–9
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Index
headphone jack
connector pinout 9–1
location 2–2, 2–7

heat sink
removal 4–44
spare part numbers 3–6, 3–17, 4–44

hinge
illustrated 3–10
removal 4–29
spare part number 3–10, 3–17, 4–30

HP SpareKey Enrollment 5–4

I
internal display switch 2–3
internal microphone 2–2, 2–7

J
jacks

audio-in 2–2, 2–7
audio-out 2–2, 2–7
headphone 2–2, 2–7
microphone 2–2, 2–7
modem 2–9
network 2–9
RJ-11 2–9
RJ-45 2–9

K
key components 2–4
keyboard

product description 1–7
removal 4–20
spare part numbers 3–3, 3–4, 3–17, 3–18, 4–20

keys
esc 2–4
fn 2–4
function 2–4
numeric keypad 2–4
Windows applications 2–4
Windows logo 2–4

L
language, changing in Computer Setup 5–5
language, chaning in Computer Setup 5–10
left-side components 2–9
legacy support, USB 5–1, 5–5, 5–7, 5–10
light components 2–5
lights

battery 2–9
caps lock 2–5
optical drive 2–8
power 2–5
wireless 2–5

M
mass storage devices, spare part numbers 3–11
memory check 5–9
memory module

removal 4–16
spare part numbers 3–8, 3–15, 3–16, 4–16

memory module compartment 2–10
memory module compartment cover

illustrated 3–9
removal 4–17

memory product description 1–3
microphone

location 2–2, 2–7
product description 1–5

microphone jack
connector pinout 9–1
location 2–2, 2–7

model name 3–1, 4–5
modem jack

connector pinout 9–3
location 2–9

modem module
removal 4–42
spare part numbers 3–5, 3–14, 4–42

modem module cable
removal 4–48
spare part number 4–42, 4–48

modem, product description 1–5
monitor port

connector pinout 9–2
location 2–9

N
network jack

connector pinout 9–3
location 2–9

numeric keypad keys 2–4

O
operating system, product description 1–7, 1–8
optical drive

location 2–8
precautions 4–2
product description 1–5
removal 4–18
spare part numbers 3–8, 3–11, 3–15, 3–16, 3–18, 

4–18
specifications 6–4, 6–5

optical drive bay bezel 3–9
optical drive bracket, removal 4–19
optical drive light 2–8
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Index
P
packing guidelines 4–3
passwords 5–4, 5–9
plastic parts 4–1
Plastics Kit

contents 3–9
spare part number 3–4, 3–17

pointing device
components 2–6
illustrated 2–6
product description 1–7

port options
ExpressCard slot 5–6
flash media reader 5–6
USB port 5–6

ports
external monitor 2–9
monitor 2–9
product description 1–6
USB 2–9

power button 2–3
power connector 2–9
power cord

set requirements 10–1
spare part numbers 3–12, 3–13

power light 2–5
power requirements product description 1–5
power-on password 5–9
processor

product description 1–1
removal 4–49
spare part numbers 3–5, 3–14, 3–15, 3–18, 4–49

product description
audio 1–5
chipset 1–2
display panel 1–2
Ethernet 1–5
external media card 1–6
graphics 1–2
hard drive 1–4
keyboard 1–7
memory 1–3
microphone 1–5
modem 1–5
operating system 1–7, 1–8
optical drive 1–5
pointing device 1–7
ports 1–6
power requirements 1–5
processor 1–1

security 1–7
serviceability 1–8
webcam 1–5
wireless 1–6

product name 1–1, 3–1, 4–5

R
recovering information 8–3
recovery partition 8–3
recovery, system 8–1
recycling

battery 11–1
display components 11–1

removal/replacement
preliminaries 4–1
procedures 4–5

restore security defaults 5–6
restoring factory settings 5–2, 5–3
restoring the hard drive 8–2
right-side components 2–8
RJ-11 connector cover 3–9
RJ-11 jack

connector pinout 9–3
location 2–9

RJ-45 jack
connector pinout 9–3
location 2–9

RTC battery
removal 4–40
spare part number 3–5, 3–13, 4–40

Rubber Feet Kit, spare part number 3–6, 3–17, 4–6
run-in test 5–4

S
SATA (Serial Advanced Technology Attachment) 

devices
AHCI (Advanced Host Controller Interface) 5–5
IDE (Integrated Drive Electronics) 5–5

Screw Kit, spare part number 3–12, 3–17
screw listing 7–1
SD Card Reader 2–7
security cable slot 2–8
Security menu 5–4, 5–9

allow reset of HP ProtectTools security keys 5–4
always prompt for HP SpareKey enrollment 5–4
Automatic DriveLock 5–4
change password 5–4
Disk Sanitizer 5–4
DriveLock 5–4
HP SpareKey 5–4
HP SpareKey enrollment 5–4
HP Sparekey enrollment 5–4
password policy 5–4
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Index
set up BIOS administrator password 5–4
System IDs 5–4
user management 5–4

security product description 1–7
service considerations 4–1
serviceability product description 1–8
set security level 5–6
setup utility

accessing 5–7
Diagnostics menu 5–9
File menu 5–8
Security menu 5–9
System Configuration menu 5–10

speaker
location 2–2, 2–3
spare part number 3–4, 3–17

specifications
computer 6–1
display assembly 6–2
DVD±RW and CD-RW SuperMulti Double-Layer 

Drive 6–4
DVD-ROM Drive 6–5
hard drive 6–3
optical drive 6–4, 6–5
system DMA 6–6
system I/O address 6–9
system interrupt 6–8
system memory map 6–7

stringent security 5–9
switch cover

removal 4–20
spare part number 3–3, 3–17, 4–20

system board
removal 4–36
spare part numbers 3–5, 3–15, 3–16, 4–36

System Configuration menu 5–5, 5–10
System Diagnostics menu 5–4
system DMA specifications 6–6
system fan 5–5, 5–10
system I/O address specifications 6–9
system IDs 5–4
system information 5–4, 5–8
system interrupt specifications 6–8
system memory map specifications 6–7
system recovery 8–1

T
tools required 4–1
top components 2–1
top cover

removal 4–32
spare part number 3–4, 3–17, 4–32

TouchPad 2–6
TouchPad button 2–6
TouchPad scroll zone 2–6

U
Unified Extensible Firmware Interface (UEFI) mode 

5–5
Universal Serial Bus (USB) port

connector pinout 9–4
location 2–9

USB legacy support 5–1, 5–5, 5–7, 5–10

V
vent 2–9, 2–10

W
warranty period 3–1, 4–5
webcam 2–1
webcam light 2–1
webcam module

illustrated 3–10
removal 4–29
spare part number 3–10, 3–16, 4–29

webcam module cable
illustrated 3–10
removal 4–31
spare part number 4–31

webcam, product description 1–5
Windows applications key 2–4
Windows logo key 2–4
Windows Vista operating system DVD 8–3
wireless antenna

disconnecting 4–15
locations 2–1
removal 4–31
spare part number 4–31

wireless antenna cable, illustrated 3–10
wireless button 2–3
wireless light 2–5
wireless module compartment cover

illustrated 3–9
removal 4–14

wireless product description 1–6
WLAN module

removal 4–12
spare part numbers 3–6, 3–7, 3–13, 3–14, 4–12, 

4–13
WLAN module bracket, removal 4–15
WLAN module compartment 2–10
workstation guidelines 4–4
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